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Before You Begin

Viewing This Manual

B Marks

A WARNING

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

A cauTtion

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

(“) IMPORTANT

Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

LLINOTE

Instructions including notes for operation and additional explanations.

B About the Text

- Copying this manual or any part of this manual without permission is strictly forbidden.

- The information in this manual is subject to change without notice.

- We have done our best to make this manual as complete and accurate as possible, and we ask you
to contact your place of purchase. If you find any omissions or mistakes in this manual.

- The text of this manual describes an example environment using a Windows 10. Some display
screens and operating procedures may differ when using a different operating system.



B Abbreviations

« Microsoft Windows 11 is abbreviated as “Windows 11"
-+ Microsoft Windows 10 is abbreviated as “Windows 10"
- Microsoft Windows 8.1 is abbreviated as “Windows 8.1"

-+ Microsoft Windows is abbreviated as “Windows”

- Canon and the Canon logo are trademarks of Canon Inc.

- Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the
United States and/or other countries.

- eneloop is trademark or registered trademark of Panasonic Group.

- Other brand and product names may be trademarks or registered trademarks of their respective
companies.



Names of Components

External View

M Top View

Keyboard
Cover
Power key

AC adapter connector
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USB connector (Type-B)

Battery cover
Battery case
Rating plate *

*The rating plate shows the

manufacturer, model name,

electrical rating, and serial number.
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o Connector for tube warmer 8 Transport roller 2

Attachment/Media cassette mount 9 Transport roller 3

Media feed port (When the Connector for ribbon cassette
attachment installed) Cutter

Display

Media delivery port

Ribbon cassette mount Blade receiver

a Transport roller 1

Jam recovery lever
Print head
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Names and Functions of Keys
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Print/
Print option

@ rFormat] key Sets the page/text input orientation and the text frame.

[Style] key Specifies character size, number of lines, and space between
characters.

[Length/Margin] key Specifies the length of one tube (or one label), character
alignment, and margins.

[Conti.] key Sets up repeat printing of a page.

[Number.] key Sets numbering for text.

G [Regist.] key Sets up the saving and loading of data.

[Symbol] key Use this key to enter a symbol.
Use [Shift]+[Enter] key to confirm a selected unconfirmed
symbol.

g [Remove] key This key is used to remove the tube or label tape from the
printer.

B [Option] key All functions can be set using this key.

m [Delete] key Deletes the currently entered characters and settings.




[Cancel] key Press this key while printing to stop printing, and then stop
after cutting the print media. If you press and hold this key for
2 seconds or more, the printer will stop without cutting.

If pressed during the operation of a function, the operation will
be canceled. Also, pressing this key while holding down [Shift]
will return you to the character input display.
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[Back Space] key Deletes the character to the left of the cursor position.

Confirm the input of unconfirmed characters or selected items.
[Enter] key Pressing this key after finalizing text input will insert a page
break at the cursor position.

Move the cursor or selected item up, down, left or right. If you

(AllwI4IIP] press this key while holding down [Shift] in the character input

A k
(Arrow keys) display, you can move to the next or previous page. (P.38)

[Print] key Displays the printing preference display and allows you to
print the currently displayed data. (P.72)

m Space key Enter a space.

[Alt] key This key is used to input characters with diacritical marks by
holding down this key while pressing the corresponding
character key.

@ [Caps Lock] key If you press this key and then enter alphanumeric characters,

they will be capitalized.

[LINOTE
+In this manual, pressing and holding down the desired key while holding down [Shift] will perform the

following operations.

Example: [Shift]+[Cancel] keys



How to Read the Display
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Prev Page Next A/< Frame Char Size | | Cont Print
‘—'—, | | #Line CharSpaceI

D 0 0 DO

Caps Lock Indicates whether the Caps Lock mode is active.
m : Active, so all alphabetic characters are entered in

uppercase.

(No indication): Normal (inactive).

Print speed Displays the printing speed settings. (P.87)
H: High L: Low

The settings for adding a half cut to tubes or label tapes are
indicated by the following symbols. (P.88)

-':'ll:l- - Half cut.

| :Not half cut, but a solid line is printed showing
where to cut with scissors, etc.

Half cut setting

:Not half cut, but a dotted line is printed showing
where to cut with scissors, etc.

(No indication) : Not half cut, and no cutting line is printed.




Remaining Ink Ribbon

Indicates the remaining capacity of the ink ribbon with a mark.

(Ribbon remaining)

1
(Out of ribbon)

(Not displayed)

:The display changes every 10%. When the
remaining capacity is low, prepare a new
ribbon cassette.

:The ribbon cassette is not loaded, or the
information cannot be read.

Power

The power source being used is indicated by the following

symbols. (P.12)
I
[=}

(Power remaining)

Ch

(Out of power)

:The AC adapter is being used.

- When the battery is being used, the
remaining battery charge is indicated by
this symbol.

(If the battery is not sufficiently charged,
the remaining capacity may not be
displayed correctly.)

a Warmer

Displays the settings for the (optional) tube warmer. (P.31)

Auto

RDY

OFF

(No indication)

:Only warms the tube during printing. When

printing is executed, the tube will be warmed
up to the set temperature, and then printing
will start.

:Warms the tube except while printing.

When printing is executed, it starts printing
immediately. "WAI" will be displayed when
the set temperature is adjusted.

: Disables the tube warmer settings.

:The tube warmer is not set.
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Cut Length/
Alignment/Margin

Displays the settings for the length (cut length) of a tube (or a label),
alignment, and margin of the current page. (P.55)

« When using the "Automatic” cut length feature (The set
value is highlighted.)

Cut Length (mm) Alignment (Centered “C")

15.0C

« When using the "Specify" cut length feature

Cut Length (mm) Alignment (Centered “C”, Left-aligned “L",

l | Right-aligned “R" )
40.0L5
L Margin (mm)

8 Cursor

Text is entered at the position indicated by a M. (P38)

a Cont Print

Displays the number of times the current page will be printed
repeatedly. (P.79)

m Character Space

Displays the character space setting for the current page.
(P48)

Lines

Displays the number of lines setting for the current page.
(P49)

Character Size

Displays the character size setting for the current page. (P.43)

Frame

Displays the frame setting for the current page. (P.45)

Orientation

Displays the print orientation and character orientation settings
for the current page. (P.46)

Page

Displays the page number of the current page. (P.37)
d : Displayed when there is a page before the current page.

p : Displayed when there is a page after the current page.

LLINOTE

- This product treats the string of characters to be printed on one tube (or one label) as one page. Press

the [Enter] key to create a new page. (Page Break)

For more information on page manipulation and editing, refer to "Creating and Editing Pages

(P60)".
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Preparing the Power Supply

Connecting the AC Adapter

A cauTion

+ Be sure to use the supplied genuine AC adapter and power cord.

w
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1 Connect the power cord to the AC adapter, and plug the AC adapter into the
7 e
%

Z/‘%@:\

printer.

2 Insert the power plug into a power outlet.

(“) IMPORTANT

- Ifthe AC adapter jack is defective or damaged, it cannot be repaired. Please purchase the AC adapter

from your point of purchase for this product.



Use with Batteries

If you are outdoors or in any other place where you do not have access to a power supply, you

can use the product with batteries.

A cauTtion

- Be sure to use fully charged "eneloop AA Standard Model Batteries (Part No. : BK-
3MCCA (for North America), BK-3MCCE (for Asia)." Do not use any other type of
battery. Failure to do so may result in fire, malfunction, or injury.
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1 Prepare 6 "eneloop AA Standard Model Batteries (Part No. : BK-3MCCA (for
North America), BK-3MCCE (for Asia)" (Sold separately).

7 Make sure that the power is turned off.

3 Remove the battery cover.

4 Insert the batteries.

® Asshown in the figure, @ insert the battery
terminal into the printer, and @ push it in.

® Paying attention to the direction in which you
insert the batteries, as marked with the @ and

O symbols.




5 Put the battery cover back on.

® Push the battery cover in until it clicks into place,
and close it completely so that there is no gap
between the battery cover and the printer.

(“) IMPORTANT

If the product has batteries installed and the AC adapter is also plugged into a power outlet, the AC
adapter will be given priority as the power supply. However, it is recommended that you remove the
batteries when using the AC adapter, as they will be drained otherwise.
If the batteries are installed and the AC adapter is connected to the product, do not disconnect the AC
adapter during printing. The product will not be able to print properly if you do so.

- When printing using battery power, even if the AC adapter is connected during printing, the power
supply will not be switched until printing is finished.

- The remaining battery power cannot be displayed correctly directly after switching the power supply
from the AC adapter to the batteries. Once printing starts, the remaining capacity will be updated.

- When using the (optional) tube warmer or when printing large characters (character size: 6mm full-
width), the batteries will be drained quickly. In such cases, we recommend the use of the AC adapter.
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Turning the Printer On/Off

Turning the Printer On

1 Pressand hold the power key for 1 second or more.

Juolesedald

N

® \When the power is turned on, the screen are "Startup display”
switched in the order "Startup display">"Ribbon
cassette information display">"Character input M K3 000
display- CABLE ID PRINTER
@ If the power is turned on without a ribbon
cassette loaded, the ribbon cassette information v
display will not be displayed. "Ribbon cassette information
display”

Ribbon information
black 40m

. 4

"Character input display”

EEL_E 2 3 0C
|
[ 0001 H/H oim 1N 1
® [fthereis any data that was displayed when The data being
the power was last turned off (or automatically edited remains.
turned off), a screen will appear to confirm Erase it?
No

whether you would like to delete the data. If
you press [Yes], the character input display will
appear with the data erased.



LLINOTE
+ Hide the initial delete check message

You can choose not to display the screen to confirm the deletion of data upon startup. When set to
"No," the program will start without deleting the data being edited.

1  Press the [Option] key.

7 Use[a]or[w]to select "Others," and then press the [Enter] key.
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Option
Print adjust A

Setting v

3 Use[a]or[¥]to select "Init. DeleteCheck" and press the [Enter] key.

Others

AutoBacklightOff A
Init. DeleteCheck

Page Display v

4  Use[a]or[w]to select "No," and then press the [Enter] key.

Init. DeleteCheck

Yes

5 Press the [Shift]+[Cancel] keys.

® You will return to the character input display.



Turning the Printer Off

1 Press and hold the power key for 1 second or more.

® The "Shutting down.." message will
be displayed, and then the printer %\
will turned off. 9 : =
& Z

2 Unplug the power plug from the power outlet.
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A cauTtion

- When disconnecting the AC adapter from the printer, be sure to remove the power

plug from the power outlet first.

(“) IMPORTANT

- Do not disconnect the power plug until the power has been completely turned off.
If you will not be using the printer for a long period of time, remove the power cord, AC adapter, USB

cable, and batteries from the printer.

LLINOTE

This product has a function that automatically turns off the power when a certain amount of time
passes without printing. For details, refer to "Changing the Auto Power Off Settings (Adapter/

Battery) (P.160)".

17
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Installing the Ribbon Cassette

(“) IMPORTANT g
o

o

- For more information on the ribbon cassette that can be used, refer to "Consumable Supplies and 3
Options (P.192)". Z

- Dispose the used ribbon cassette according to local government regulation.

1 oOpen the cover.
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3 Remove the new ribbon cassette packing material.

(“) IMPORTANT

+ Do not touch the IC chip on the ribbon cassette. Doing so may
render the ribbon cassette information unreadable.

4 Remove any slack in the ribbon.

(“) IMPORTANT

- Ifthe ribbon is loose, it may not operate properly.

19
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Names of Preparation/ Print Using a Maintenance/ Trouble-

Components

Computer Printer Settings shooting

P

20

® Push the cassette in until it clicks into the place.
If the ribbon cassette is slack, it may not operate properly.

5 Install the ribbon cassette into the printer.

6 Close the cover.

(“) IMPORTANT



Loading the Print Media

Loading a Tube

(“) IMPORTANT

- Do not use the following types of tubes. Not only will the product not print cleanly, but use with such

tubes may also cause a malfunction.
- Broken -Crushed  -Twisted - Uneven thickness

- Soiled - Uneven - Wet
- You cannot print on dirty tubes. Wipe off any dirt or dust with a dry cloth. Also, do not use tubes that

have oil or other stains that cannot be wiped off.

LLINOTE

Please purchase commercially available tubes for use. For more information on the sizes that can be
used, refer to "Print Media (P.191)".
- The procedure for removing set print media from the printer, refer to "Replacing the Print Media

(P27)".
- Periodically clean or replace the cleaner of attachment. Dirt on the cleaner will cause print smears. For

details, refer to "Cleaning/Replacing the Cleaners (P.155)".

1 Prepare the attachment.

® For tubes (round)
Use the cleaner (blue) by attaching it to the tube attachment.

Tube Attachment
FA-TPIVFAVE
® Forflat tubes

Use the cleaner (blue) by attaching it to the (optional) plate and flat tube attachment.

Plate and Flat Tube Attachment
RER(R) 759 MF2-7 (B) 749 FAV b
Use plate only with compatible models.
RERGSHEE CRBOLCER LA,

21
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Print Using a Maintenance/ Trouble-

Computer Printer Settings shooting
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4 Set the size switch lever to match the size of the tube.
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5 Insert the tube.

® Fortubes (round)
Insert the tip of the tube into
the media feed port in the
direction shown in the figure,
and push it in until it hits
transport roller 2.

® Forand flat tubes
Insert the tip of the flat tube
into the media feed port in
the direction shown in the
figure, and push it in until it
hits transport roller 2.

K
Transport roller 2

Hﬁ =

LLINOTE

If it is difficult to pass the tube through the attachment, set
the tube in place while pressing the tube retainer lever with

your finger.

(“) IMPORTANT

- Ifthe tip of the tube is inserted as shown in the figure,
the tube may get stuck during printing, the print may be
chipped, or the cut position may be off.

- Ifthe tip of the tube is bent due to winding, etc, fix it so that it is straight, or cut off the bent portion

before placing it in the printer.
- To prevent the print media from running out during printing, or to prevent the shortened print media
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from getting stuck inside the printer, use a tube of sufficient length.

S1USIU0D

- If the tube is not set correctly, this device may print onto the transport roller.

6 Close the cover.
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Slusjuod

Loading a Label Tape Cassette

(“) IMPORTANT
- Dispose the used label tape cassette according to local government regulation.

LLINOTE

- The procedure for removing set print media from the printer, please refer to "Replacing the Print
Media (P.27)".
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1 Check the condition of the cassette.

® [fthe release paper has a high spot, or the tips
are not aligned, cut that portion off.

up3/Andu

® Pull out the end of the tape by about
5 mmto 7 mm as shown in the figure.
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LLINOTE

- If label tape or other material has gotten into the

cassette, use tweezers to pull out the tape tip, as shown
in the figure.
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® Align the cassette with the
slot on the printer, and push
itin firmly until it clicks into

3 Install the cassette into the printer.

place
4 Close the cover.



Replacing the Print Media

To replace the print media installed in the printer with a different one, follow the procedure
below.

LLINOTE

- Forinformation on the print media that can be used with this product, refer to "Print Media (P.191)".

B ForThin Tubes (@1.5 mm)

o
s
[1°}

wo
M
= =
Ss
© =
(=]
>
=~

1 Open the cover.

2 As shown in the figure, pull the tube out while pressing the jam recovery
lever in the direction of the arrow.

3 Load the print media. (P.21)
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B For Other Print Media

1 Turn on the power. (P.15)

2 Press the [Remove] key.

® The following screen will be displayed.

3 Select "Yes" with [4] or [p] and press the [Enter] key.

® The print media will be rotated backwards.
Unload print media?

Yes No

b

Unloading...

4 Open the cover.

5 (When using a tube)

Pull out the tube.

® [f the tube cannot be removed, close the cover
and press the [Remove] key again.

28
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6 Remove the attachment (or media cassette, tube warmer).

. . . ) % ‘/

When using the attachment or media cassette / j\w
While pulling the lever to the right, lift it upward
to remove it.
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® When using the tube warmer.
Grasp the tube warmer while pushing its two
stoppers and pull it straight upward.

(¥) IMPORTANT

-+ Do not lift the tube warmer diagonally. It may damage the connector on the bottom of the tube

warmer.

LLINOTE

- Keep the media cassette with the slack of the tape removed.

29



7 Load the print media.

® When using a tube, refer to "Loading a Tube (P.21)".
® When using a media cassette, refer to "Loading a Label Tape Cassette (P.25)".

(“) IMPORTANT

+ When the print media feed is reversed, the ribbon in the ribbon cassette may become slack. If the
ribbon is slack, remove the ribbon cassette and remove the slack in the ribbon. (P.19)

- For soft tubes, using the [Remove] key to feed backwards may damage the tube. In such cases, follow
the procedure described in "For Thin Tubes (1.5 mm) (P.27)".
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Using the (Optional) Tube Warmer

The tube warmer is an attachment that warms up tubes that have become stiff at low
temperatures to make them easier to print on and feed into the printer.

A cauTion

- Do not leave the tube warmer heated with a tube set in it. Excessive heating of a
tube may cause a fire.

w
(0]
—
=
pel

- Do not put your fingers in the tube warmer's tube insertion and tube delivery ports.

Juolesedald

Doing so may result in burns.

Set the Tube in the Tube Warmer

(¥) IMPORTANT

- The tube warmer can be used with the following tube types and sizes. This device cannot print
correctly on other types of tubes.
Type: Tube, Clear tube
Size: 1.5 t0 6.5 mm internal diameter

- Ifthe tube gets too warm, the device may not print on it correctly. Print as soon as possible after
loading the tube.

- Do not use the following types of tubes. Not only will the product not print cleanly, but use with such
tubes may also cause a malfunction.
- Broken -Crushed -Twisted -Uneven thickness
-Soiled -Uneven -Wet

- Itis not possible to print on dirty tubes. Wipe off any dirt or dust with a dry cloth. Also, do not use
tubes that have oil or other stains that cannot be wiped off.

- If the tube warmer cleaner is dirty, it may cause blurred printing. Clean or replace it periodically. For
more information, refer to "Cleaning/Replacing the Cleaners (P.155)".

LLINOTE

- Forinformation on how to remove a tube that has been set into the printer, and on how to remove
the tube warmer, refer to "Replacing the Print Media (P.27)".
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1 Prepare the tube warmer.
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2 Open the cover.
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3 Set the tube warmer in place.

aABS/ULd

® |Insert the connector of
the tube warmer into the
connector for the tube
warmer on the printer and
push down on it vertically
until it clicks into place.

J9Indwo)
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4} Set the size switch lever to match the size of the tube, and set the tube.
(P22)

® Set the tube in the same way as when using the tube attachment.
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5 Close the cover.
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6 Turn on the printer. (P.15)

dniag
Juoneledaid

7 Check the control settings of the tube warmer.

® The current control settings of the warmer will (Auto)
be shown on the display.

up3/Andu

® Forinformation on how to control settings of
the warmer, refer to "Changing the Control
Setting of the Tube Warmer (P.34)".

aABS/ULd

(“) IMPORTANT

+ When the tube warmer is not set, the tube warmer control settings are disabled.

J9Indwo)
e buisn g

- If you cannot print correctly even with the tube warmer (for example, printing is blurred), change the
temperature setting of the tube warmer. (P.35)

LLINOTE

-+ When "Label" or "Wrap Around" is selected for the print media in the print settings, and "ON" is
selected, "OFF" will appear on the display. To change the print media, press the [Print] key. (P.72)
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Changing the Control Setting of the Tube Warmer

Switches between tube warmer settings.

Setting Details
Auto Only warms the tube during printing. When printing is executed, the tube
(Auto) will be warmed up to the set temperature, and then printing will start.
ON Warms the tube except while printing. When printing is executed, it starts
printing immediately. "WAI" will be displayed when the set temperature is »
(RDY) ) G
adjusted. o
OrF Disables the tube warmer settings. - g
(OFF)

[Example] To start printing immediately, set the warmer control setting to "ON".

1 Press the [Option] key.

2 Use[a]or[¥]to select "Warmer," and then press the [Enter] key.

Option
Connect A
Character Edit W

3 Use[a]or [¥] to select "Warmer Control," and then press the [Enter] key.

Warmer

Warmer Control

Warmer Temp.

4 Use [a] or [w] to select "ON," and then press the [Enter] key.

Warmer control
Auto

OFF

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input display.
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Changing the Temperature Setting of the Tube Warmer

If you cannot print correctly even with the tube warmer (for example, printing is blurred), change
the temperature setting of the tube warmer. The default setting is "Mid."

[Example] Printing is blurred, so set the tube warmer temperature to "High."

1 Press the [Option] key.

5
wo
2 Use[a]or[¥]to select "Warmer," and then press the [Enter] key. é* -
&
Option =
Connect A
Character Edit W

3 Use [a] or [w] to select "Warmer Temp.," and then press the [Enter] key.

Warmer

Warmer Control

4 Use [a] or [¥] to select "High," and then press the [Enter] key.

® The temperature can be adjusted to three levels: Warmer Temp.
"High," "Mid," and "Low.
Mid
Low

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

LLINOTE

+ We recommend using the AC adapter when printing with the tube warmer, as it drains the batteries
quickly. Also, if you want to print with less battery drain, set the warmer temperature to "Low."
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Basic Input Operations

Before Input

B About Pages

This product treats the string of characters to be printed on one tube (or one label) as a single
page. Press the [Enter] key to create a new page. (Page Break)

Press Press
[Enter] key [Enter] key
200V ¢ ‘ Pump RoomHl ¢ am ’
(o001 (0002 40003 |
200V Pump Room @
(Page 1) (Page 2) (Page 3)

Also, if you display the "Page Display', you can check the page number of the currently displayed
page and the total number of pages in the data. In addition, "Memory used" allows you to check
the available space on the character input display.

Page Display
Page 41 of 53 ————— The page number of the currently

Memory used displayed page/ the total number of pages

| I— The available space on the character input display

Currently used capacity

Follow the procedure below to display the "Page Display.

1 Press the [Option] key.

2 Usela]or[¥]to select "Others," and then press the [Enter] key.

Option
Print adjust A
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3 Use [a] or [w] to select "Page Display" and press the [Enter] key.

® Page Display screen will appear on the display. Others
® Press the [Shift]+[Cancel] keys to return to the Init. DeleteCheck A
N
character input display. G RIET v
Page Display

Page 41 0of53

Memor‘ used

4 Press the [Shift]+[Cancel] keys.

B How to Use the Cursor

The mark that indicates the position for entering text is called the "cursor!
Use the arrow keys ([a], [¥], [4], [ D)) to move the cursor when using this device. The key
operations for moving the cursor are as follows.

Key press Cursor movement
[ D] Move to right one character or to the next page.
(4] Move to left one character or to the previous page.
[A] Go to the line above.
[(w] Go to the line below.
[Shift]+ [ a] Go to the top of the page.
[Shift]+ [ W] Go to the end of the page.
[Shiftl+ [ ] Go to the top of the previous page.
[Shift]+ [ »] Go to the top of the next page.
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[Example] Input "Res7-1"

Slusjuod

1 Input'Res7-1"

syusuodwo)
JO sauweN

® Enter [Shift]+[R], [E], [S], [7], [-], and [1] in this
order.

Res7—1H

® When entering capital letters, hold down [Shift]
and press the desired key.

dniag
Juoneledaid

® [f you make a mistake, use the [Back Space]
key to delete the character, and then enter the
correct character. (P41)

LLINOTE

« Press the [Caps Lock] key to switch to the uppercase alphabet input mode. To return to the previous

up3Anduj

mode, press the [Caps Lock] key again.
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Entering Symbols

You can use the input symbol function to enter symbols that cannot be entered using the
keyboard.

[Example] Input "Q."

1 Press the [Symbol] key.

2 Usethe arrow keys ([a], [w], [4], [P]) to select "Q" from the list of symbols.

® The symbol screen is divided into two groups. To oudiuync A
switch between groups, press [Shift] + [P ] (or AAEOUNC =
(€. yeEeis@ v g
G
® For symbols that can be entered, see "List of =
Symbols (P.196)". =
3 Press the [Enter] key.
® ") will be displayed at the position indicated by 0 X (E Guync A
»). A OUNC =
® [fyou want to delete the character displayed at ”_C;;]/.E cigud v
the position indicated by pp,
press the [Back Space] key while holding down
[Shift].
4 Press the [Shift] + [Enter] keys.
® "()" will be entered.
0] |

40



Deleting Characters

There are two ways to delete a character: using the [Back Space] key.

Slusjuod

[Example] Change "27V" to "2V."

JO SWeN

syusuodwo)

1 Move M (the cursor) to "V:"

»
D
£ 8
=]
27 ° g
=3
2
2 Press the [Back Space] key. 3
m
o
® The character to the left of the cursor position =
will be deleted.
2V hy
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1 ~
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(0)
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Deleting All Characters That Have Been Entered

This deletes all the characters entered in the page. (Delete All)
For Delete All, select one of the following.

Text only:

Delete all pages of text, leaving the format setting of the last page.

Text+settings:

Reset the character size and other format settings to their default values, and delete text from all

pages.

LLINOTE

« About Format Settings

"Text+settings" returns the format settings to their default values. Format Settings in this product

refers to the following function settings.

Function name Default setting Function name Default setting
Character Size 3 mm full-width Orientation Hor/Hor char
Frame None Continuous Print Off (one time)
Cut Length Automatic Character Space Narrow
Alignment Centered Lines 1 line
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[Example] Delete all pages of input text and restore the character size and other format
setting to their default values.

1 Press the [Delete] key.

2 Use [w] to select "Text+settings," and press the [Enter] key.

Delete All

Text onl
[ ——

® A confirmation screen will appear.

3 Select "Yes" with [4] or [p] and press the [Enter] key.

® Thedisplay returns to the character input Delete text and
display. reset settings?
Yes No

42



Editing Characters and Lines

This is how the character size is set. The character size can be selected from those below; the
default value is "3 mm full-width"

- 1.3 mm - 2.6 mm o 4 mm
> full-width half-width half-width

I2 I

2mm 2.6 mm 4 mm

= half-width 200 | £ll-width 200V | full-width
2mm 3mm 6 mm

o full-width half-width 20V half-width

3mm 6
200V full-width 200V fu?lmidth

[Example] Set the character size to "3 mm half-width."
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1 Display the page where you want to change the character size.

2 Press the [Style] key.

3 Use [a] or [w] to select "Character Size" and press the [Enter] key.

Style

Lines
Character Space

4 Use[a]or [¥]to select "3 mm half-width"

® "X"will appear next to character sizes that Character Size

cannot be selected. 3mm half-width A
3mm full-width
4mm half-width v
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5 Press the [Enter] key.

® The display returns to the character input
display.

® The character size setting can be checked on the
display.

[3mm-]

® [fyou select "half-width," the text will be
displayed in half-width.

LLINOTE

- The character size can be set for each page.
- Even if you select half-width characters, symbols will be printed in full-width.

+ Some character sizes cannot be selected depending on the number of lines, the cut length setting,
and the size of the print media.
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+ No error message will be displayed even if the print data extends beyond the width (top and bottom) of the print

media. Refer to the following to set the character size and frame.

Maximum Printable Character Size

Print Media Maximum Printable Character Size
Type Size (mm) Without frame (mm) With frame (mm)
Tube 15 13 X
Clear e ' ’ (printing not possible)
Shrink tube 25 26 13
3 3 26
4 4 4
5 6 4
6 6 6
6.5 6 6
7 6 6
8 6 6
9 6 6
10 6 6
Flat tube X
= 13 (printing not possible)
25 1.3 13
3 4 26
4 4 3
5 6 4
6 6 6
6.5 6 6
Label 6 3 2
9 6 4
12 6 6
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Surround Text with a Frame

This allows you to surround text with a frame. The default setting is "None."

[Example] Enclosing text in a frame.

1 Display the page where you want to change the frame settings.

2 Press the [Format] key.

3 Use[a]or [¥]to select "Frame" and press the [Enter] key. é
Format setting E
Orientation =

4 Use[a]or [¥w]to select "On," and then press the [Enter] key.

® The display returns to the character input

Frame
display. Off
@ The frame shapes setting can be checked on the
display.
|
=)

LLINOTE

- The frame can be set for each page.

- When the cut length is specified, the frame may not be set.

- Depending on the settings of the number of lines, character size, cut length, etc. and the size of the
print media, the frame may not be printed correctly.

- No error message will be displayed even if the print data extends beyond the width (top and bottom)

of the print media. Refer to "Maximum Printable Character Size (P.44)" for information on
character size and frame settings.

45



Specifying the Orientation and Character Direction

The orientation (Vert/Hor) and text direction (Vert char/Hor char) are specified in the
"Orientation" settings. The default setting is set to "Hor/Hor char!"

Setting Details Print Image

Hor/Hor char | Orientation: horizontal -~

. . . . Pump Room Cc1
(Default Setting) | Text direction: horizontal 2V

Orientation: vertical
Vert/Vert char . . X ::: 0SEa rooE o -
Text direction: vertical

[Example] Set to "Vert/Vert char."

1 Display the page for which you want to change the orientation.

2 Press the [Format] key.

3 Use[a] or [¥] to select "Orientation" and press the [Enter] key.

Format setting

Frame

4 Use[4]or[p]to select "Page.

® |[fyou select "All" in this screen, the orientation of Orientation ERQE/All

all pages will be changed. Hor/Hor char

Vert/Vert char |-«

5 Use[a]or[¥]toselect "Vert/Vert char"

® X" will appear next to orientation that cannot Orientation [ERER/All
be selected. Hor/Hor char |i2s]

Vert/Vert char

46
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6 Press the [Enter] key.

® The display returns to the character input

display.

® The orientation settings can be checked on the

display.

LLINOTE

- The orientation can be set for each page.

If you change the orientation, a confirmation message will appear if any characters do not fit within

the page. To cancel the changes, select "No!"
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Specify the Character Spacing

Sets the space between characters. The default setting is set to "Narrow."

Setting Details Print Image

Narrow

No character spacin Pump Room
(Default Setting) pacing

Medium Character spacing 0.5 mm Pump Room

Wide Character spacing 1.0 mm Pump Room

[Example] Setting the character spacing to "Wide."

1 Display the page where you want to change the character spacing.
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Press the [Style] key.

3 Use [a] or [w] to select "Character space” and press the [Enter] key.

Style
Character Size
Lines

Character Space

4 Use[a]or [v]to select "Wide"

® "X"will appear next to character space that Character Space
cannot be selected. Narrow
Medium

5 Press the [Enter] key.

® The display returns to the character input
display.

® The character space settings can be checked on lﬂ]
the display.

LLINOTE

- The character space can be set for each page.

- When the cut length is specified, the character space may not be changed.
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Specifying the Number of Lines

Sets the number of lines. The default setting is "1 Line!"

Setting

Details Print Image

1 Line (Default Setting)

Input in one line 12V

2 Lines

Input in two lines 2

[Example] 2 line input.

1 Display the page where you want to change the number of lines.

2 Press the [Style] key.
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3 Use[a]or[w]toselect "Lines" and press the [Enter] key.

Style
Character Size
Character Space

4 Use [A] or [w] to select "2 Lines."

® "X"will appear next to the number of lines Lines
that cannot be selected. 1Line

5 Press the [Enter] key.

® The number of lines setting can be checked

on the display.

® Use the arrow keys ([a], [w], [4], [P]) to
move between the lines.

LLINOTE

-+ The number of lines can be set for each page.

- If after entering text, you would like to reduce the number of lines, delete the second line of text and

then change the line number setting.
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«+ You may not be able to select "2 Lines" depending on the selected character size.

SJUIU0D

+ No error message will be displayed even if the print data extends beyond the width (top and bottom) of
the print media. It is recommended that you refer to the preview to make sure that no characters are

missing before printing. (P.76)
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You can print a fixed string of characters with a sequential number or letter of the alphabet. The
possible numbering settings are as follows.

Setting Set range Print Image
Decimal 010999 o Pump Room 1) o Pump Room 2) o Pump Room 3)
Hexadecimal OtoFFF Pump Room 09 Pump Room 0A Pump Room 0B
Upper case letter AtoZ O Pump Room A) O Pump Room B) O Pump Room C)
Lower case letter atoz Pump Room a Pump Room b Pump Room c

Example: Set the numbering from 1 to 10 after "Pump Room"
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O Pump Room 1 ) O Pump Room 2 ) O Pump Room 3 ) ------ O Pump Room 10)

1 Enter "Pump Room

® Move the cursor to the position where you
want to enter the number.

Pump Roomlll

Press the [Number.] key.

3 Use [a] or [w] to select "Decimal Settings," and press the [Enter] key.

Number Settings
A
Hexa Settings
A to Z Settings v

4 Use [a]or [w]to select "Start value," and then enter "1."

Decimal Settings
End value : 0
[0 to 999 ]

51



5 Use[a]or[¥]to select "End value" and enter "10."

Decimal Settings
Start value: 1

End value : 10
[0 to 999 ]

6 Press the [Enter] key.

® You will then be returned to the padding
character settings screen.

/ Use[a]or [¥] to select "None."

5
©
=
Paddini character iy
Zero
Space

8 Press the [Enter] key.

® The display returns to the character input
display. The sequentially numbered control —
_ m RoonmNN
character (N) will be entered after "Pump P NN
Room

® When printing is executed, "Pump Room 1"
to "Pump Room 10" will be printed.

LLINOTE

+ Numbering can be set only once per page.

- If you want to cancel the numbering setting, use the [Back Space] key to delete the control character (N
) of the numbering.

- If you want to set numbering in descending order, such as "10 to 1," enter "10" for the "Start value" and
"1" for the "End value!"
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The settings for padding characters are as follows.

Rl o Pading characters (labszatieons) (buadecns) (luneicanld

A leading "0" will be entered as a
Zero (Lpume 8ooms) (]pumeoom o9) (Jpume foom 10)

padding character.

A leading space will be entered as a
Space (Leumereons) (Leumpiooms) (rump foomio)

padding character.

SUEIlop)
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If all the sequential numbers have the same number of digits, or if an alphabetic character is selected
for the sequential number, the settings screen for padding characters will not be displayed.
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Underline 6, 9

The numbers 6 and 9 can be underlined to distinguish them from each other. The default setting
|S ”Off_"

16 29 96

1 Press the [Option] key.

2 Use [a] or [¥] to select "Print Settings" and press the [Enter] key.

Option
Page Settings A

Delete All v

3 Use[a]or [w] to select "Underline 6, 9" and press the [Enter] key.

Print Settings
Half cut
Full cut

Underline 6, 9

4 Use [a] or [w] to select "On," and then press the [Enter] key.

® When printing, the numbers 6 and 9 will be Underline 6 and 9
underlined. Off

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

LLINOTE

- The settings for this function are applied to all pages. You cannot change the settings for each page.

54

S5
o

c

—t
=~
m
o
=



Setting the Cut Length

The length of one tube (or one label) is called the "Cut Length." The default setting is "Automatic."

0 Al T) Pump Room )

Cut length

Setting Details Print Image

Automatically sets and prints the
optimal cut length based on the
number of characters entered,
Automatic the size of the characters, and the O
(Default Setting) | spacing between the characters.
The alignment is centered, and the
margins are 2 mm on the left and 2
mm on the right.
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Al n Pump Room )

Prints with the specified cut length. | e.g.) "Left" alignment
When "Specify" is selected for
"Cut Length," you can specify the O IN ) PumpRoom )
alignment (and margin).

Specify

55



Specify the Cut Length and Alignment

This is how the cut length and alignment are set. If you set the cut length to "Specify," you can
change the alignment. The default setting for alignment is set to "Centered"

Setting Details Print Image
Maﬁgin Mar‘gin
Centered
: Centers the text.
(Default Setting) Pump Room
Cut Length
Margin (2 -5 mm)
Aligns text to the left end (in the —
Left direction of the start of the text). ‘ '§
Margins can be set in the range of Pump Room =
o
2to5mm. =
Cut Length
Margin (2 -5 mm)
Aligns text to the right end (toward ‘
Right the end of the text). Margins can
. D Pump Room
be set in the range of 2 to 5 mm.
Cut Length

LLINOTE

- When "Centered" is selected and the maximum number of characters for the cut length is used, the
minimum margin is 0.7 mm in total for both sides.
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[Example] Creating a tube as follows.

Margin (5 mm)
‘ Alignment (Left)

O PMom )
~

Cut length (40 mm)

1 Press the [Length/Margin] key.

2 Use [Aa] or [¥] to select "Cut Length," and press the [Enter] key.

B onath
d

Alignment

Batch Setting

3 Use [A] or [w] to select "Specify," enter "40.0" (Cut Length), and then press the
[Enter] key.

® The value can be set by entering numbers or Cut Length
using arrow keys (4 1/[ ). Autoatic
® Cutlength can be entered in the range of 8 mm [Onr1n]m

to 150 mm (4 mm to 150 mm for label only) in 0.1
mm increments.

® Press the [Enter] key to return to the character
input display.

Press the [Length/Margin] key.

5 Use [a] or [¥] to select "Alignment" and press the [Enter] key.

Cut Length
Cut Length

J
Batch Setting

57
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G Use [a]or [¥]to select "Left" and enter "5" (margin).

® The value can be set by entering numbers or Alignment

using arrow keys (4 1/[ p1). Centered

IS B [2 to 5
Right : 5mm [2 to 5]

] Press the [Enter] key.

® The display returns to the character input ( o )
display. Input the characters.

® Cutlength and alignment can be checked
on the display.

LLINOTE

- The cut length and alignment can be set for each page.
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- Depending on the character size, some cut lengths cannot be specified.

- If you want to change the cut length of all pages, use "Batch Setting." (P.59) In Batch Setting, the
"Cut Length," and "Alignment," settings are applied to all pages.

- Approximately 60 mm from the print start position, there may be a slight difference between the
specified cut length and the print result.

- Depending on your print media and environment, the cut length and margins may differ from the
settings. If the results are not as expected even after setting the cut length and margins, fine-tune the
cut length and print position. For more information on fine adjustment of the cut length and print
position, refer to "Fine Adjustment of Print Position and Cut Length (P.80)".

- When the print media is a label, if the cut length is less than 8.0 mm, the alignment is "Centered" and
the settings cannot be changed.
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Setting the Cut Length Settings for All Pages.

You can set the Cut Length settings (Cut Length and Alignment) for all pages at once.

1 Press the [Length/Margin] key.

2 Use [a] or [w] to select "Batch Setting," and press the [Enter] key.

® The cut length setting screen will appear. Cut Length

Cut Length

Alignment

=3
©
=
3 Use [Aa] or [w] to select "Specify," enter the cut length, and then press the iy
[Enter] key. -
® The value can be set by entering numbers or Cut Length
using arrow keys ([ 4 /[ D). Automatic
® Press the [Enter] key, and the alignment setting [ : 1;}2} :

screen will appear.

4 Use [a] or [w] to select the desired setting, and then press the [Enter] key.

® When you select "Left" or "Right," set the margins. Alignment
Ps8)
® Press the [Enter] key to return to the character Ili(iegﬂht %mm g :co> g}
input display after the data has been checked
and changed.
LLINOTE

- Ifthere is data that exceeds the cut length due to changes in the batch settings, a confirmation
message will appear to delete the data that exceeds the cut length. To cancel the operation, select
No”

- Ifyou are unable to input text due to batch setting, set the cut length of the page to "Automatic" or
change the character size.
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Creating and Editing Pages

To create a new page, press the [Enter] key. (Page Break)

[Example] Create a new page after the currently displayed page.

200V

(Page 1)

1

[ |
1 1
200V | |
: o

(Page 1) (Page 2)

S5
o
c
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=~
m
o
=

1 Move the cursor to the end of the line.

200V
0001
7 Press the [Enter] key.
® A page break will be performed and a new page
will be created. -
® You can check the page number of the currently (w2

displayed page on the display. Also, arrows ( 4/
p ) before and after the page number indicate
that there is a page before or after the currently
displayed page.

LLINOTE

- The format setting of the new page will be the same as the previous page. For more information
about format setting, refer to "About Format Settings (P.42)".
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Copying a Page

You can copy the page where you have entered text and paste it before or after another page.

[Example] Copy the first page and paste it after the second page.

2oovJ P””“’J a
Room

(Page 1) (Page 2) (Page 3)

zoovJ Pump - | a
Room ]
1200V
)
[}

1
i
(Page 1) (Page 2) —JI (Page 4)

Copy and past

Display the page to be copied (the first page).

Press the [Option] key.

3 Use[a]or [¥] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit
v

4 Use [a] or [¥] to select "Copy," and press the [Enter] key.

® A confirmation screen will appear. Page Edit

Insert A
Delete
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5 Use[4] or [p]to select "Yes" and press the [Enter] key.

® The first page will be copied and you will be Copy data of page
returned to the character input display. 1?7

Yes No

Press the [Option] key.

7 Use [a] or [w] to select "Page Edit" and press the [Enter] key.

Option
Warmer A 3
Character Edit =1
v m

8 Use [a] or [w] to select "Paste" and press the [Enter] key.

® A confirmation screen for the paste location Page Edit
will appear. Copy A
Cut
v

9 Use [q] or [ p] to enter "2" (page), and use [A] or [w] to select "After."

Paste data where?

fg oo

10 Press the [Enter] key.

® The copied page will be pasted to the
specified location and you will be returned

A ‘ Pasting data...
to the character input display.

ERERC0O0000
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Moving Pages

Cut the page on which you have entered text and paste it before or after another page.

[Example] Cut the second page and paste it after the third page.

2oovJ P“'“PJ C
Room

(Page 1) (Page 2) (Page 3)

mTTTTTTT |
1 1
200V i Pump a Pump
] Room ! Room
L )
(Page 1) (Page 2) (Page 3)

S5
o

c

—t
=~
m
o
=

| 4

Cut and past

1 Display the page to be moved (page 2).

Press the [Option] key.

3 Use [a] or [¥] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit
v

4 Use [a]or [w]to select "Cut," and press the [Enter] key.

® A confirmation screen will appear. Page Edit

Delete A

E&
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5 Use[4] or [p]to select "Yes" and press the [Enter] key.

® The second page will be cut and you will be Cut data of page
returned to the character input display. 2?7

= No

Press the [Option] key.

7 Use [a] or [w] to select "Page Edit" and press the [Enter] key.

Option
Warmer A 3
Character Edit =1
v m

8 Use [a] or [w] to select "Paste" and press the [Enter] key.

® A confirmation screen for the paste location Page Edit
will appear. Copy A
Cut
v

9 Use [q] or [ p] to enter "2" (page), and use [A] or [¥] to select "After.’

Paste data where?

B oo

10 Press the [Enter] key.

® The cut page will be pasted to the specified
location and The display returns to the

Pasting data...
character input display.

ERRRCO0O000
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Inserting a Page

Inserts a blank page at the specified location.

[Example] Insert a new blank page between the first and second pages.

2oovJ P”mpJ C
Room

(Page 1) (Page 2) (Page 3)

E ________ ! Pump
200V E Room a
L e

(Page 1) (Page 2) (Page 3) (Page 4)

S5
o

c

—t
=~
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1 Display the page at the position where you want to insert a blank page (page
2).

Press the [Option] key.

3 Use [a] or [¥] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit
v

4 Use [a] or [¥] to select "Insert," and then press the [Enter] key.

® A confirmation screen will appear. Page Edit
A

Delete
Copy v

5 Select "Yes" with [4] or [p] and press the [Enter] key.

® A blank page will be inserted on the second
page, and you will be returned to the Insert at page 27
character input display.

Yes No
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Delete a Page

Deletes a specified page. When you delete a page, the data entered on that page will also be
deleted.

[Example] Deleting the second page.

zoovJ P”"‘F’J C
Room

(Page 1) (Page 2) (Page 3)

5

200V o
=
=3

m
(Page 1) =
=

1 Display the page you want to delete (page 2).

2 Press the [Option] key.

3 Use [a] or [w] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit

v

4 Use[a]or [w]to select "Delete;" and press the [Enter] key.

® A confirmation screen will appear. Page Edit
Insert A
Copy v

5 Use [4]or [p]to select "Yes" and press the [Enter] key.

® The second page will be deleted and you
will be returned to the character input Delete page 27?
display.
ey Yes No
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You can divide the data which is entered two lines in one page into two pages.

[Example] Page division of page 3.

A1 c—1
A2 B-1 =

AT B-1 ©=i E=2
A2

1 Display the page to be divided (page 3).

S5
o
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2 Press the [Option] key.

3 Use [a] or [w] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit
v

4 Use [a] or [w] to select "Division," and press the [Enter] key.

Page Edit
Cut A
Paste

5 Use [A] or [w] to select "Specify,” and press the [Enter] key.

® |[fyou select "All" all pages will be divided. Page division

All

6/



6 Use [q] or [ p] to enter "1" (for page) and press the [Enter] key.

® The second line of the third page will be
created as the fourth page, and you will be
returned to the character input display.

LLINOTE

How many pages do
you divide from the
current page?

Page count:

b

Dividing pages...
EEENE0000

- If you divide a page of one-line input, the same data will be created for two pages.

[Example] Divide data that contains a page of one-line input with "All".

| =

[a
c2 |

| A2

1

| A-1 | A-2 | B-1 | B-1 | c-1 | c-2 |

S —

- Pages with numbering cannot be divided.

- When you divide a page, the settings such as character size and cut length will be changed. It is

recommended to save the file before dividing it.

- The following settings will be changed to their default settings. (P.42)
Character Size / Frame / Cut Length / Orientation / Continuous Print / Character Space

- Since the character size will be the default setting, the cut length may change depending on the
data. Also, if the cut length exceeds 150 mm, the data for the excess length will be deleted.
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Page Combining

You can combine two pages of data into two lines on one page.

[Example] Combine pages 3 to 6.

B-1 C-1

1 Display the page you wish to make into a combined one (page 3).

S5
o

c
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2 Press the [Option] key.

3 Use[a]or [¥] to select "Page Edit" and press the [Enter] key.

Option
Warmer A
Character Edit
v

4 Use [a] or [w] to select "Combining" and press the [Enter] key.

® The page combining selection screen will Page Edit
appear. Paste A
Division
v

5 Use [a] or [w] to select "Specify," and press the [Enter] key.

® [fyou select "All" all pages will be combined Page combining
into one page with two lines. All
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6 Use [q] or [ ] to enter "4" (page) and press the [Enter] key.

® Pages 3 to 6 will be combined and you will
be returned to the character input display.

LLINOTE

How many pages do
you combine from the
current page?

Page count:

b

Combining pages...
EEENE0000

- Pages with numbering or pages with two line input cannot be combined.

-+ When you combine pages, the settings such as character size and cut length will be changed. It is

recommended to save the file before combining.

- The following settings will be changed to their default settings. (P.42)
Character Size / Frame / Cut Length / Orientation / Continuous Print / Character Space

- Since the character size will be the default setting, the cut length may change depending on the
data. Also, if the cut length exceeds 150 mm, the data for the excess length will be deleted.
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Basic Printing Operations

After you have finished entering and editing text, you can print.

[Example] Print two tubes as shown below (using 4.0 mm tubes).

0 Al n Pump Room )

1 Display the data to be printed, and press the [Print] key.

2 Use[w]to select "Set to print" and enter [2].

® Use the numeric keys or the arrow keys ([ 4 1/ "Printing preference display”
[ p]) to enter the data. If you make a mistake, Print TEra o R
press the [Back Space] key to delete the entry. Sets to printh %
@ You can specify the number of prints from 1 to Tube ®3.0mm 9
10 Range: All ®

@ This operation will print 2 pages of data twice.

3 Select "Tube @3.0mm" with [w] and press [4], [P] or the [Enter] key.

Print /Preview

Sets to print: 2
Tube ® 3. 0mm

Range: All

4 Select "Tube" with [a] or [w] and press the [Enter] key.

® The following print media can be selected with Select Media Type
this product.
Tube / Shrink tube / Label / Clear tube / Wrap Shrink tube
Around / Flat tube Label v
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5 Use[a]or[¥]to select "a4.0mm," and then press the [Enter] key.

® You will then be returned to the printing
preference display.

Tube size
®2. 5mm
@ 3. Omm

(¥) IMPORTANT

- Inthe following cases, the printer will not be able to detect that the tube has run out during printing,
and may print on the transport roller. Make sure that the tube is long enough not to be lost during
printing before starting printing.

- When the tube size is 1.5 mm

- When the print media is set to "Clear Tube."

LLINOTE

- For setting a tube of a size that is not on the selection list, refer to "Tube Size Selection
(Recommended) (P.75)".

6 Use the arrow keys ([a], [w], [4], [P]) to select "Preview;" and press the [Enter]

key.

® Check the print preview. Print /CITVEE

® For more information on the print preview, refer to Sets to pri ntq:) 2
"Checking the Print Preview (P.76)". Rlﬁgg' AéhOmm

LLINOTE

- No error message will be displayed even if the print data extends beyond the width (top and bottom)
of the print media. It is recommended to refer to the preview to make sure that no characters are
missing before printing.

7 Use [q] to select "Print" and press the [Enter] key.

IS/ Preview

Sets to print: 2
Tube ® 4. omm

Range: All

/3
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8 Use[a]or [w]to select "Print head" and press [Enter] key.

® Printing will be started. Media Head Position
Cutter

(¥) IMPORTANT

- Check the head position of the loaded print media, then select "Cutter" or "Print head." Select "Print
head" to print on the print media directly after loading it.

Cutter in - :
o

Print head

- If the media head position is set incorrectly, you may end up printing on the transport roller or have a
big margin at the tip.
- After the media head position is set, the "Media Head Position" screen will not be displayed again in

o
=
35
=
~
w
()
<
()

the following cases.
- When the cover is not opened.
- When the power is not turned off.
- When you do not change the type or size of the print media in the print settings.
- When the feed function (P.171) and remove function (P.28) are not used.

9 Removing the tube.

® When printing is finished, the tube will be
automatically cut (Full cut). Also, a cut (Half cut)
can be made between the tubes.

(¥) IMPORTANT

- After printing, remove the print media from the printer to prevent warping or deformation of the print
media.

- Do not place any objects around the outlet of this product. If there is an object blocking the outlet, the
tube or label tape may not be ejected straight and may be cut in a bent shape.

/4



- Do not pull the tube or label tape forcibly during printing. Doing so may result in printing failure or
malfunction.

LLINOTE

- To cancel printing, press the [Cancel] key. The printer will stop printing and cut the print media, then
stop. If you press and hold the key for two seconds or more, the printer will stop without cutting.
- When setting the tube, refer to the following for the print settings.

Tube Size Selection (Recommended)

Print Media Print Setting
Type Size (mm) Size selection

Tube 215t00220 1.5mm

Clear tube 2.1 10 ©2.5 2.5 mm

Shrink tube 02610835 3mm
3.6 to @4.5 4 mm
24.6 10 5.5 5mm
5.6 t0 6.2 6 mm
06310 06.7 6.5 mm =
06810075 7 mm &
07,610 08.5 8 mm B
8.6 10 9.5 9mm
29.6t0 210 10 mm

Flat tube 215t022.0 7.5 mm
22110925 2.5 mm
22610 @3.5 3mm
3.6 t0 94.5 4 mm
24.6 10 5.5 5mm
5.6 10 6.2 6mm
6.3 10 6.5 6.5 mm
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Checking the Print Preview

Before printing, you can check the print preview on the display.

1 Display the data to be printed, and press the [Print] key.

2 Use[P]to select Preview, and then press the [Enter] key.

® The print preview will be displayed, flowing from Print /TIVEE
right to left. Sets to print: 1
Tube ®3.0mm
+ While pressing [A] or [w], the display will Range: All
stop.
« If you hold down [ 4 ], the image will be '
displayed in fast forward.
- Press [ p]to display the next page. 200V Pump
- Press [Cancel] key to cancel preview display.

o
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® When the preview display finishes, you will
return to the printing preference display.

LLINOTE

+ When you specify the following print media, the line

indicating the width of the print media is not shown in the

preview. 200V Pump

- Tube (@7 mm to @10 mm), shrink tube (27 mm to @10

mm), clear tube (@7 mm to @10 mm)

- Labels (12 mm)

- The preview may not exactly match the actual print result.

76



Printing by Specifying a Print Range

You can specify a specific page or range to print. The default setting for the print range is set to
"All pages.”

Setting Details

All pages

Prints all pages.
(Default Setting) l pag

Cursor page Prints only the currently displayed page.

Specified page Prints the range specified by "Start page" and "End page""

[Example] Print pages 2 to 4 of the following data.

Pump
2OOVJ RoomJ @] Q J a ‘J

(Page 1) (Page 2) (Page 3) (Page 4) (Page 5)

1

O Pump Room )O C1 )O 2 )
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1 Display the data to be printed, and press the [Print] key.

2 Use[a]or[¥]to select "Range’, and use [4] or [p] to select "Specified."

Print /Preview
Rangell  Specified |
Start page: 1

End page : 1
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Use [a] or [w] to select "Start page" and enter [2].

® Use the numeric keys or the arrow keys
({4 /I P ]) to enter the data.

Print /Preview

Range: Specified
Star: pagel

End page : 2

Use [a] or [¥] to select "End page" and enter [4].

® Use the numeric keys or the arrow keys
([ 4 V[ P ]) to enter the data.

Print /Preview
Range: Specified

Start page: 2
End page §

Use [A] to select "Print" and print. (P.72)

/8

IS/ Preview

Sets to print: 1
Tube ® 3. 0mm

Range: Specified
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Setting Up Repeat Printing of a Page

If you want to set up repeat printing for a page, enter the number of times in "Continuous Print."
For Continuous Print, you can set the number of prints from 2 to 200 per page.

[Example] Print the second page three times.

Pump
ZOOVJ RoomJ a

(Page 1) (Page 2) (Page 3)

200V Pumg Room PumB Room Pume Room )|

1 Display the page to be printed in Continuous Print.

7 Press the [Conti.] key.

o
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3 Use[a]or [¥] to select "Set count" and enter "3" (the number of times for

Continuous Print).

® Use the numeric keys or the arrow keys Continuous Print
({4 1/[ P ]) to enter the data ff .
' et countjild 3|
® The value can be set in the range of 2 to 200 [ 2 to 200 ]
(times).

4 Press the [Enter] key.

® The display returns to the character input
display.

® The number of times for Continuous Print can
be checked on the display.

5 Print. (P.72)
LLINOTE

- Continuous Print is set for each page.

- When you want to cancel the Continuous Print setting (print once), set "Off" in step 3 above.
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Adjustment of Printing Results

Fine Adjustment of Print Position and Cut Length

Depending on your print media and the environment, the print position may be shifted or cut
length may be different from the setting. If you cannot get the result you expected even after
setting the cut length and margins, fine-tune the print position and cut length.

For this product, the following adjustments can be set for each type of print media (for vertical
adjust, by type and by size).

Function

Details

Top adjust

Fine-tune the print start position.

Vertical adjust

Fine-tune the print position in the vertical direction.

Length adjust

Fine-tune the cut length.

(“) IMPORTANT

- If the situation is not improved by adjusting the adjustment function, clean the transport roller. (P.152)
Also, make sure that there is no dirt on the print media.

80
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B Fine-tuning of the Print Start Position (Top Adjust)

[Example] When printing on a tube in the "Centered" position, the text is shifted to the left,
so move the print start position 2.0 mm to the right.

(lpeeeco )
N

Move the print start position
2.0 mm to the right.

1 Press the [Option] key.

2 Use [Aa] or [¥] to select "Print adjust” and press the [Enter] key.

Option
File A
Setting v

3 Use [a] or [¥] to select "Top position" and press the [Enter] key.

Print adjust
A
VerticalPosition
Length v
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4 Use [a] or [w] to select "Tube," and press the [Enter] key.

Top adjust
Tube N ormai PN
ShrinkTube Normal

Label Normal w

5 Use [ ] to display "R 2.0 mm" and press the [Enter] key.

® Input the adjust value by [ 4 ] (left direction) or [ Top position adjust
» 1 (right direction). A
® You can adjust the range from Left 2.5 mm to [ Right 2. 0mn __|

Right 2.5 mm in 0.1 mm steps.

6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

81



B Fine-tuning the Print Position in the Vertical Direction (Vertical
Adjust)
[Example] When printing on a tube (26.0 mm), the print position is shifted upward, so move
the print position downward by 0.5 mm.

Al Move the print position
. ABER — downward by 0.5 mm.

1 Press the [Option] key.

2 Use [a] or [w] to select "Print adjust" and press the [Enter] key.

Option
File A
Setting v

3 Use [a] or [w] to select "VerticalPosition," and press the [Enter] key.

Print adjust
Top position A

VerticalPosition

Length v

4 Use[a]or [w]to select "Tube," and press the [Enter] key.

Vertical adjust
ShrinkTube
Label

5 Use [a] or [¥] to select "@6.0 mm" and press the [Enter] key.

Tube size
®5.0mm  Normal A

®6.5mm  Normal w
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SUEIlop)

6 Use [w] to display "Down 0.5 mm" and press the [Enter] key.

® Use [A] (upward)/[W®] (downward) to enter the Vertical adjust
adjust value. g =
@® You can adjust the range from 1.0 mm upward % H L e el '§ E
to 1.0 mm downward in 0.1 mm increments. §. S

7 Press the [Shift]+[Cancel] keys.

dniag
Juoneledaid

® The display returns to the character input
display.
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B Fine-tuning the Cut Length (Length Adjust)

[Example] When printing on a tube with a cut length of "30 mm," the tube is printed shorter
than the setting, so the cut length is increased by 2 mm.

—

The cut length is increased by 2mm.

Press the [Option] key.

2 Use [a] or [w] to select "Print adjust” and press the [Enter] key.

Option
File A
Setting v

3 Use [a] or [¥] to select "Length," and press the [Enter] key.
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Print adjust
Top position A

VerticalPosition
v

4 Use[a]or [w]to select "Tube," and press the [Enter] key.

Length adjust
Tube | A

ShrinkTube 0. 0mm

Label 0.0mm w
5 Use [P] to enter "+2.0mm" and press the [Enter] key.
® Use[d ] (negative direction) or [ p] (plus Length adjust
direction) to enter the adjust value. You can also -
input using [+1/[-] keys or numeric keys. '

® You can adjust the range from -7.5 mm to 7.5
mm in 0.1 mm increments.
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SUEIlop)

6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

syusuodwo)

(“) IMPORTANT

+ No further adjust in the negative direction will be applied when there is no more space for adjust (other
than characters) or when the minimum cut length or less is reached. For the minimum cut length of
each print media, refer to "Specifications (P.189)".

If the problem is not corrected by using the length adjust, set the half cut to "None" and cut with
scissors. For more information about the half cut setting, refer to "Changing the Half Cut Settings

(P.88)".
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Changing the Print Density

Depending on the print media you are using and the environment, the printing may be too light
or too dark. In such cases, adjust the print density.
The density can be set for each print media. The default setting is "3""

[Example] Adjust the print density of the tube so that it is the darkest.

1 Press the [Option] key.

2 Use [a] or [w] to select "Print adjust” and press the [Enter] key.

Option
File A
Setting v

3 Use[a]or [w] to select "Print density," and press the [Enter] key.

Adjustments
Full Cut Depth A
Full Cut Motion

Print densit
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4 Use [a] or [w] to select "Tube," and press the [Enter] key.

Print density
ShrinkTube 5
Label 3
5 Select "5" with [4] or [ ] and press the [Enter] key.
o A" mark will be displayed under the current Print density
setting.
® Density can be set in the range of 1 (lightest) to 12 i 4

5 (darkest).

6 Press the [Shift]l+[Cancel] keys.

® The display returns to the character input
display.
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Changing the Print Speed

If printing is blurred or uneven, adjust the print speed.
The default setting is "High"

[Example] Setting the speed to "Low" because the text is blurred.

1 Press the [Option] key.

2 Use [a] or [¥] to select "Setting," and press the [Enter] key.

Option
Print adjust A
Others

3 Use [A] or [w] to select "Print Speed," and then press the [Enter] key.

Setting
A
Display contrast
Backlight (ADPTR)VW
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4 Use [a] or [¥] to select "Low," and then press the [Enter] key.

1

® The speed can be adjusted to two levels: "Low' Print speed
and "High"
High
5 Press the [Shift]+[Cancel] keys.
® The display returns to the character input III
display. -
® The print speed setting can be checked on the

display.
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Cutter Settings

This product automatically cuts the print media when printing is finished. (Full cut) In addition,
a half cut is made between the tubes and labels after printing, so that you can cut the tubes by
hand or cleanly peel off labels from release paper.

0 Al D Pump Room )

Half cut Full cut

B Changing the Half Cut Settings

The default setting is "(Half Cut) On."
If you do not want to use a half cut, you can print the cut line (solid/dotted line).

Y
Cut line =4
Half cut . Details Print Preview <
settings 4
<
[¢”)
On
After printing, cut lines are added (I PumpRoom )
(Default -
) between tubes and labels.
Setting) Half cut
No cut between tubes or labels 0 Al Pump Room )
Off after printing, and no cut line will ‘
be printed. No cut line
A solid cut line will be printed O Al ) PumpRoom )
Off Line between tubes and labels after
printing. Line
A dotted cut line will be printed 0 Al i PumpRoom )
Dotted between the printed tubes and ‘
labels. Dotted
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[Example] Printing a cut line (Dotted) without a half cut.

1 Press the [Option] key.

2 Use [A] or [w] to select "Print Settings" and press the [Enter] key.

Option
Page Settings A

Delete All v

3 Use [a] or [w] to select "Half Cut" and press the [Enter] key.

Print Settinas

Full cut
Underline 6, 9

o
4 Use [a]or [w]to select "Off" and press the [Enter] key. =
(%]
Half cut 3
On

5 Use[a]or[¥]toselect "Dotted" and press the [Enter] key.

® The display returns to the character input
display.

6 Press the [Shift]l+[Cancel] keys.

® The display returns to the character input (i)
display.

® You can check the half cut setting on the display.
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B Changing the Full Cut Settings

The default setting is "End only"

Setting Details Print Preview
Endonly |Cuts the print Full cut
(Default | media at the end \
Setting) of printing. 0 Al D Pump Room T) Al T) Pump Room ‘j
Full cut Full cut

Cuts match the 0 Al D Pump Room 0 Al D Pump Room ‘]
Each set '

number of prints. ‘ | ‘

1st group 2nd group

[Example] Full cut for all pages printed.

1 Press the [Option] key.

2

Use [a] or [¥] to select "Print Settings" and press the [Enter] key.

o
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Option
Page Settings A

Delete All v

Use [a] or [w] to select "Full cut" and press th

e [Enter] key.

Print Settings
Half cut

Underline 6, 9

Use [a] or [¥] to select "Each set," and then p

ress the [Enter] key.

Full Cut

End onli

Press the [Shift]+[Cancel] keys.

® The display returns to the character input display.
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Adjusting the Cut Depth

If the cutter blade is becoming less sharp or half cutting is too deep, adjust the depth of the cut.
Adjustment can be set for both "Half cut" and "Full cut"

B Changing the Cut Depth for Half Cut

The cut depth for half cut can be set for each print media. The default setting is set to "Normal."

LLINOTE

- If cutting is difficult depending on the material of the print media, adjust the motion of the cut.
(P.96)

[Example] The half cut of the label tape is too deep (or too shallow), so adjust the half cut
depth.

1 Press the [Option] key.

2 Use [a] or [w] to select "Print adjust" and press the [Enter] key.
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Option
File A

Setting v

3 Use [Aa] or [¥] to select "Half Cut Depth," and then press the [Enter] key.

Adjustments
Half Cut Depth I
Half Cut Motion
Full Cut Depth w

4 Use [a]or [w]to select "Label," and press the [Enter] key.

Half Cut Depth
Normall\
Clear Tube Normal
WrapAround Normal W

91



5 Use [A] or [w] to select the half cut depth adjustment value, and press the

[Enter] key.

® The Half Cut Depth can be setin 11 levels: Half Cut Depth
"Deep (1-5)," "Normal," and "Shallow (1-5) !ﬁl!

® Fach time you press [Al], the cut is deepened by [ Deep 1 ]
one step.

® FEach time you press [w], the cut will become
shallower by one step.

6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

(“) IMPORTANT

- If you make the cut depth deeper than necessary, the cutter and blade receiver will wear out quickly.

LLINOTE

- Ifthe half cut is too deep even when the cut depth is adjusted to the shallowest setting, the blade
receiver may be worn out. Replace the cutter and blade receiver. (P.156)
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B Changing the Cut Depth for Full Cut

The cut depth for the full cut can be set for each print media. The default setting is set to

"Normal"

[Example] The full cut of the tube is not cut properly, so make the cut one step deeper.

1 Press the [Option] key.

2 Use [a] or [w] o select "Print adjust" and press the [Enter] key.

Option
File A
Setting v

3 Use [a] or [w] to select "Full Cut Depth," and press the [Enter] key.

Adjustments
Half Cut Depth A
Half Cut Motion

Full Cut DepthR4

4 Use[a]or [w]to select "Tube," and press the [Enter] key.

Full Cut Depth
A

ShrinkTube Normal

Label Normal ¥

5 Use [a] to select "Deep 1" and press the [Enter] key.

® Full Cut Depth can be set in four levels: "Deep
(1~3)" "Normal"

® Fach time you press [Al, the cut is deepened by
one step.
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6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

(“) IMPORTANT

« If you make the cut depth deeper than necessary, the cutter and blade receiver will wear out quickly.
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Using Forced Full Cut

If the situation is not improved after adjusting the cut depth for full cut, use "Forced full cut" With
Forced full cut, the cut is made to the deepest point. If the situation is not improved even after
using Forced full cut, replace the cutter. (P.156)

1 Press the [Option] key.

2 Use [a] or [w] to select "Others," and then press the [Enter] key.

Option
Print adjust A

3 Use[a]or [¥] to select "Forced full cut," and then press the [Enter] key.

® A confirmation screen will appear. Others

Remove A

Cleaning
Forced full cutih\4

o
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4 Select "Yes" with [¢] or [p] and press the [Enter] key.

® Full cut will be performed.
Cut print media?

Yes No

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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Adjusting the Cut Motion

If it does not cut well when you change the print media, adjust the motion of the cut.
Adjustment can be set for both "Half cut" and "Full cut"

LLINOTE

- Ifthe cutter blade is becoming less sharp, adjust the depth of the cut. (P.91)

B Changing the Motion of the Half Cut

The motion of the half cut can be set for each print media. The default setting is set to "Normal."

[Example] The half cut of the label tape is not cut properly, so the cut is made stronger.

1 Press the [Option] key.

2 Use [a] or [w] to select "Print adjust” and press the [Enter] key.

;U

Option 5

File A &

2
Setting v

3 Use[a]or [¥] to select "Half Cut Motion," and then press the [Enter] key.

Adjustments

Half Cut Depth A
Half Cut Motion

Full Cut Depth w

4 Use[a]or [w]to select "Label," and press the [Enter] key.

Half Cut Motion
Tube Normal A
ShrinkTube Normal
Normalh4
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Use [w] to select "Intense" and press the [Enter] key.

® You can set the Half Cut Motion in two levels,
"Normal" and "Intense.

Half Cut Motion
Normal

Intense

Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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B Changing the Cutting Motion of Full Cut

You can set the motion of the full cut for each print media. The default setting is set to "Normal!

[Example] The tube is not cut properly when using a full cut, so make the cut stronger.

1 Press the [Option] key.

2 Use [a] or [w] to select "Print adjust” and press the [Enter] key.

Option
File A
Setting v

3 Use [a] or [¥] to select "Full Cut Motion," and press the [Enter] key.

Adjustments
Half Cut MotionA

Full Cut Depth
Full Cut Motionis

4 Use[a]or [w]to select "Tube," and press the [Enter] key.

Full Cut Motion

NormalJPY

ShrinkTube Normal

Label Normal W
5 Use[w]to select "Intense" and press the [Enter] key.
® Full Cut Motion can be set in two levels: "Normal" Full Cut Motion
and "Intense. Normal

6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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Saving and Loading Text Data

Saving a File

You can save the text data you have created as a "File" in the device. In addition, the product
comes with 10 pre-made "folders," and each folder can hold up to 99 files.

Pump
200V a
Room

(Page 1) (Page 2) (Page 3)

File1 File 99
1 o
=
. . :
wm
Q
<
)

Folder 1 Folder 10

[Example] Save the created data in "Folder 1" with the file name "A-1"

1 Press the [Regist.] key.

2 Use [a] or [¥] to select "Save," and press the [Enter] key.

File
Load
Delete

3 Select "Folder 1" and press the [Enter] key.

Select Folder
Folder 1
Folder 2
Folder 3 v
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Slusjuod

4 Enter"A-1"(file name), and then press the [Enter] key.

® You can enter up to 8 characters for the file
Input file name

name. A—1H

syusuodwo)

5 Select "Yes" with [4] or [p] and press [Enter] key. -
[0}
ke

® The "Saving.." message will be displayed, and Save as s
then the display returns to the character input A—1 ? %
display. Yes No

=)
XS
=

(¥) IMPORTANT A

Do not turn off the power while the file is being saved. If the power is turned off while saving a file, the

data may be destroyed.

LLINOTE

- For more information on character input, refer to "Basic Input Operations (P.37)".

9ABS /Ul

For the number of characters that can be saved in the printer, refer to "Specifications (P.189)".

o
N =
- If you try to save a file with the same name as a file that has already been saved, the following message g =
will appear. If you want to overwrite the file, click [Yes]. E g
D Q
XXXXXXXX &
already exists.
Overwrite?
No

/adueuU3UIR

- The file name of the saved data cannot be changed. If you want to change the file name, save it again

sBuIIaS Jaug

with a new name.
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Loading a File

There are two types of loading for saved files: "New" and "Add." Depending on the selected
mode, the data will be loaded as follows.

Setting Item Details

New Text only Only the data currently being edited will be erased and
replaced with the loaded data.

Text+settings | The data and format setting currently being edited will be
erased and replaced with the loaded data and format setting.

Add Text only Adds the loaded data to the last page of the data currently
being edited.

The format setting of the last page currently being edited
will be applied to the loaded data.

Text+settings [ Adds the loaded data to the last page of the data currently
being edited.

The format setting at the time of file saving will be applied to
the Loaded data.
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LLINOTE

- For more information on format setting, refer to "About Format Settings (P.42)".

[Example] Load the data in the file named "A-1" in "Folder 1" and its format setting, and add
it to the last page of the data currently being edited.

1 Press the [Regist.] key.

2 Use [a] or [¥] to select "Load" and press the [Enter] key.

File
Save
Delete
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3 Use[a]or [¥] to select "Add" and press the [Enter] key.

Load
New

4 Use [a] or [w] to select "Text+settings" and press the [Enter] key.

Add

Text onl
e A

5 Use [a] or [w] to select "Folder 1" and press the [Enter] key.

Select Folder
Folder 1
Folder 2
Folder 3

6 Use[a]or [¥]to select "A-1," and then press the [Enter] key.

® An "X"will be displayed next to the name of files Select File
that cannot be "Add" loaded due to the size of A—1
the data. A—=2
A—3
7 Select "Yes" with [4] or [p] and press the [Enter] key.
® The "Loading.." message will be displayed, and Add
then the display returns to the character input A—1
display. text+settings?
No
® The last page of the loaded data will be
displayed
[LLINOTE

- When a file with text exceeding the cut length is inserted into data with a specified cut length, if you
load it as "text only," the characters past the cut length will be deleted, then the text will be displayed.
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Deleting a File

This is how to delete a saved file.
Select one of the following options for file deletion.

One file:

Deletes only one file in the folder.

Folder contents:

Deletes all the files in the folder.

All files:

Deletes all files in all folders.

[Example] Delete the file named "A-1"in "Folder 1."

1 Press the [Regist.] key.

2 Use [a] or [w] to select "Delete," and press the [Enter] key.

File
Save
Load

3 Use[a]or [¥] to select "One file," and then press the [Enter] key.

® Select "One file" "Folder contents," or "All files." Delete

Folder contents
All files

4 Use [a] or [w]to select "Folder 1," and then press the [Enter] key.

Select Folder
Folder 1 [N
Folder 2
Folder 3 v
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5 Use [a] or [¥] to select "A-1" and press the [Enter] key.

Select File

(A—1 LS
A—2 3 F
A3 Y EE
S o

6 Select "Yes" with [q] or [p] and press the [Enter] key.

o
o]
" . " . B U\'g
® The "Deleting.." message will be displayed, and Delete 235
then the display returns to the character input A—1 ? = S
display. Yes No -
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Changing the Folder Name

This is how to change the name of a folder.
The product comes with 10 folders ("Folder 1" to "Folder 10").

[Example] Rename "Folder 1" to "Pump.”

1 Press the [Regist.] key.

7 Use[a]or[¥]toselect "Save," and press the [Enter] key.

File

Load
Delete

3 Use[a]or [¥] to select "Folder 1" and press the Space key.

ael

Select Folder >

Folder1 ____I§ &

Folder 2 g
Folder 3 v

4 Press the [Back Space] key to delete all characters in "Folder 1"

Input folder name
Folder 1TH

5 Enter "Pump" (folder name), and then press the [Enter] key.

® You can enter up to eight characters for the
Input file name

folder name. Pumpl
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6 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

LLINOTE

- For more information on character input, refer to "Basic Input Operations (P.37)".
-+ Toreturn the changed folder name to the original file name ("Folder 1" to "Folder 10"), press the [Back
Space] key in step 4 above to erase all characters, and then press the [Enter] key.
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Installing the Software

The "MK Desktop Utility" application software specially designed for this product allows you to
input and edit text on your computer.

Install the MK Desktop Utility and Printer driver

Install the "MK Desktop Utility" application software and the printer driver.
This section explains how to install the "MK Desktop Utility" application software and the printer
driver at the same time.

(“) IMPORTANT

- For more information on the MK Desktop Utility operating environment and printer driver, refer to
"System Requirements for Software (P.191)

n
- Log on as a user with administrative privileges.
- Close any virus detection programs or programs that run in the background on the system beforehand.

- If the printer and computer are connected with a USB cable, unplug the connected USB cable.

1 Download the software on the computer.

)
0 =
g =
3c

wv
S5
[CR
[«%)

® Connect to the internet from a computer and
access the following Canon website.
- Usersinthe US.A
https://www.usa.canon.com/internet/
portal/us/home/support/

- Users in the South & Southeast Asia
https://asia.canon/en/support/download

2 Open the decompressed file, double click “setup.exe”.

® The installation program starts.

v o | 2 SewchConon Mkso mic.

® |[f [User Account Control] dialog box appears,
click [Yes].
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3 Select the model, and then click [OK].

Please select the model.

[\Mmﬂo

syusuodwo)

4 Select the installation type, and then click [Installation].

Juoneledaid

® When installing either the MK Desktop Utility or
the printer driver, select "Custom."

® When you click [Installation], the screen for
starting the installation of the MK Desktop Utility
will appear.

[ MKSD00/MK3000 Applcaton
[ ]MK300 Printer Driver

up3/Andu

5 Click [Next].

aABS/1ULId

Welcome to the InstallShield Wizard for HK
Desktop Uity

The Instalhield Wizard vil stall MK Desktop Usity an
Your computer. To continue, dck Next.
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6 Read the license agreement carefully, select [ accept the terms of the license

agreement], and then click [Next].

® The license agreement for the MK Desktop Utility
is displayed.

License Agreement
Please read the folving lcense agreement carefly.

Software License Agreement
[This is a legal agreement ("Agreement”) between you and Canon

[Finetech Nisca Inc. "CFN) and governing your use of CFN's
E the related manuals or any printed

[software programs
[material thereof (the "Software") for eertain CFN's printers (the
‘Printers").

-
|

] Select the destination folder.

® [f you want to install the software in the
displayed folder, click [Next].

@ [f you want to change the destination folder,
click [Change] and specify the folder to be
installed.

‘Ohoose Destination Location
Selct folder where setup will instal files.

nstall MK Deskiop Uty to-

NProram Fils (x#ONGanon Fintech NiscoWMKLK

rstatsneis

N (=) =

8 Click [Install].

® The installation of "MK Desktop Utility" will start.

110

Ready to Install the Program
The wizard s ready to begn nstallston.

‘Cick Instal 10 begi the nstalaion.

ek Back. Clck Cancel o

Hyou
ext the wizard.
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O dlick [Finish.

® The installation of "MK Desktop Utility" is
completed.

® When you click [Finish], the printer driver
installation start screen appears.

[ | e ) e

10 Cdlick INext].

Welcome to the InstallShield Wizard for Canon
HK3000 Printer Driver

The nstalShied Wizard il nstal Canon MK3000 Printer
Drivr on your computer. To contnue, dick Next.

11 Read the license agreement carefully, and then select [| accept the terms of

the license agreement] and click [Next].

® The license agreement for the printer driver is e
Please read the following lcense agreement carefully.

displayed.
‘Software License Agreement -

| |
[This is a legal agreement ("Agreement”) between you and Canon
[Fineteeh Nisca Inc. "CFN) and governing your use of CFN's

lsoftware programs including the related manuals or any printed
Imaterial thereof (the "Software”) for certain CFN's printers (the
Printers").

[READ CAREFULLY AND UNDERSTAND ALL OF THE
S w TEe

' @1 accept the terms of the kcense agreement ' [em |
it

= ()
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12 Click [Installl.

LLINOTE

- If the Windows Security screen appears, check the box for
"Always trust software from CANON FINETECH NISCA INC"

and click [Install].

11000,
‘cable. Cick [instal] to start the installaton.

Would you like to install this device software?

Nome:Canon Prnters
B putisher CANON FINETECH NISCA INC

‘
(O e e— )]
=

software s sae 10 nstal?

13 dlick [OK.

Canan MK3000 Printer Driver - InstallShield Wizard

Restart the PC, then connect the USB cable to the device and tun it on.

=

14 Select [Yes, | want to restart my computer now.] and click [Finish].

112

InstaltShield Wizard Complete

The InstalShield Wizard has sucoesstul instaled Canon
MK3000 Prter Diver. Before you can use the program, you
must restatyou compute.

@ Yes, | wank o restart my compuler no

O No. I wil restast my computes laer.

Click Finishto conglete sep.
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15 After restarting the computer, connect the printer to the computer with the

USB cable.

16 Turn on the printer. (P.15)

17 Press the [Option] key.

18 Use [a] or [#] to select "Connect" and press the [Enter] key.

® The message "Waiting for data.."is displayed,
and the printer is ready to print from a computer.
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Option
Connect RN
Warmer
Character Edit W

b

PC Connect

Waiting for data...
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19 Open the printer folder and confirm that the printer icon is displayed.

® ForWindows 11: p—— -
Select [Start] > [All apps] > [Windows Tools] ee———— — g
> [Control Panel] > [Hardware and Sound] > - EE
[Devices and Printers]. o %
® ForWindows 10: ?
Select [Start] > [Windows System Tools] > =7

[Control Panel] > [Hardware and Sound] >

Juoneledaid

[Devices and Printers].

® ForWindows 8.1:
Right-click [Start] > [Control Panel] > [View
Devices and Printers].

=)
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The installation of the "MK Desktop Utility" application software and the printer driver is

complete.
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Uninstalling the MK Desktop Utility and Printer Driver

This will uninstall the "MK Desktop Utility" application software and the printer driver.
This section explains how to uninstall the "MK Desktop Utility" application software and the
printer driver at the same time.

1 Disconnect the USB cable.

® After confirming that no printing is in progress, turn off the printer and then
disconnect the interface cable.

2 Click [Start] > [Windows System Tools] > [Control Panel] > [Programs and
Features].

® ForWindows 11
Select [Start] > [All apps] > [Windows Tools] > [Control Panel] > [Programs and
Features].

® For Windows 8.1

From the desktop charm, click [Settings] > [Control Panel] > [Programs and Features].

3 Select "MK Desktop Utility" from the list and click [Uninstall].

)
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® A confirmation message will appear.

LLINOTE

- User Account Control may be displayed. If it appears, click [Yes].

4 Select [Delete], and then click [Next].

® A confirmation message will appear.

Welcome
Modfy, repair, o remove the program.

cop
e aurent nstaaton. Cckane of e aptons biow.
ORepair

ﬁ’ Renstal a program features instaled by the previous setup.

T3 Remove shntaed feares.

- -
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5 Click [Yes].

MK Desktop Uity - InstallShield Wizar

syusuodwo)

6 Click [Finish].

® The uninstallation of "MK Desktop Utility" is
completed.

Juoneledaid

up3/Andu

7 Select "Canon MK3000 Printer Driver" from the list, and then click [Uninstall].

® A confirmation message will appear.

LLINOTE

User Account Control may be displayed. If it appears, click [Yes].

aABS/1ULId
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8 Select [Delete], and then click [Next].

® A confirmation message will appear. - »=
Modty, repsr, o remove the program. % %
s 0 ﬁ g
Owodfy =N
¥ = g8
ORepar

ﬁ ‘Renstal al program features nstaled by the previous setup.
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O Click[Yes.

10 select "Yes, 1 will restart my computer now." and click [Finish].

® The uninstallation of the printer driver is

completed.

Uninstall Complete

InstafShield Wizard has rished urinstaling Canon MK3000
Fiite Driver

@ Yes, | wenk o restart mp compuler now.

O No. I wil restart my computes laer.

Click Finishto conglete sep.

The uninstallation of the "MK Desktop Utility" application software and the printer

driver is complete.
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Connecting to a Computer

To print from your computer, switch the product into the PC connection mode.

1 Connect the printer to the PC with the USB cable.

2 Tum on the printer. (P.15)

3 Press the [Option] key.

4 Use [a] or [¥] to select "Connect” and press the [Enter] key.

® The message "Waiting for data..." is displayed, Option
and the printer is ready to print from a computer. A D
Warmer g2
Character Edit W RS
a3
o]

b

[PC Connect

Waiting for data...

LLINOTE

- When you operate the printer from the keyboard, the PC connection state is canceled. Make sure that

"Receiving.." is not shown on the printer's display, and then press the [Cancel] key.
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Starting Up/Exiting the Program

1 Double-click the [MK Desktop Utility] shortcut icon % on the desktop.

syusuodwo)
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® Once launched, the main screen will be
displayed.

® You can also start the program in the following
way.
For Windows 11:
Start menu > [All apps] > > [MK Desktop Utility] =i
> [MK Desktop Utility]
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=
For Windows 10: =
Start menu > [MK Desktop Utility] > [MK Desktop ?
Utility] -
For Windows 8.1:

1) Move the mouse pointer on the Start screen
and click the down arrow displayed at the

JaIndwo)
e buisn uLg

bottom of the screen.
2) Select [MK Desktop Utility] from the All Apps
screen (Apps View).

SBUIIAS Jajug
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(“) IMPORTANT

- If the message "Printer utility DLL could not be found."

@ o
is displayed, the printer driver installation has not been 33
PrinherruﬁlityDU‘mldmthefum (o) c
completed. Follow steps 15 through 19 in "Installing the Operation cannot be done. = %
" Q
Software (P.113). m
- If the same error occurs again, reinstall the printer driver.
(P.108)

Xipuaddy
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Exit the MK Desktop Utility.

1 Click the - (Close) button in the upper right corner of the main window.

syusuodwo)

@ Alternatively, click [Exit] on the [File] menu.
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Screen Configuration

Main Screen

The main screen of the MK Desktop Utility is organized as follows.
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[Fie® EGHD Viewl) Remote®) Helpl) ) wvo

(Cru =s um ek nEREas) | %5
i) Pt e Craracter T =
E Orientation Frame Setlength printing ares. Algnment Character Size. gy Lines g

_ e s T R el e B R RO L T 2
9mm v

Selection Send  Page Ist Line 2nd Line 3rd Line Continuous.

cd 1 H
== g
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— 5

[Press [F1] to display the help menu. e a

o=
Menu bar For more information, refer to "Menu Bar (P.122)". S 2
=
2 &

Toolbar For more information, refer to "Toolbar (P.124)". z 3
QU

There is a Data Toolbar, a Send Toolbar and an Edit Toolbar.

Format Setting Area Displays the formatting information for the selected page.
For more information about format setting, refer to
"Configure the Format Setting (P.133)".

SBUIIAS Jajug
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Data List Displays the list of data being edited. o o
5 o
Preview Area Displays the image of the printed result. % &
(]
Q
@ statusBar Displays information about the current status.
Print Media Selection Sets the type and size of the print media. z
Area ?‘3
S5
x

LLINOTE

+ Functions not supported by this printer are displayed in light gray.
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The menu bar displays the functions of the MK Desktop Utility. Click on a menu to display a
drop-down list of submenus.

LLINOTE

- Functions not supported by this printer are displayed in light gray.

M [File] menu

New Creates a new data list. (P.125)

Open Open an existing file or CSV file to load data. (P.126)

Add Open another file and add it to the data currently being edited.
(P130)

Save Overwrite and save the data currently being edited.(P.131)

Save As Save the data currently being edited in a separate file which you will

specify the name of. (P.131)

Select printer

Select the printer to be used.

Print

Print the data currently being edited. (P.138)

Exit

Exits the MK Desktop Utility. (P.120)

B [Edit] menu

Undo Invalidates the previous operation.

Redo Re-enables the operation that was invalidated by "Undo""

Cut Cuts the specified content and pastes it to the clipboard.

Copy Copies the specified content to the clipboard.

Paste Pastes the contents of the clipboard.

Delete Deletes the specified portion.

Numbering Automatically create pages by assigning consecutive numbers or

letters to a fixed string of characters. (P.136)
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Send page selection

Add or remove check marks from multiple pages at once.

Page Cut Cut the specified page and paste it to the clipboard.

Page Copy Copy the contents of the specified page to the clipboard.

Page Paste Pastes the contents of the clipboard to the front of the specified page.
Page Insert Inserts a blank page before the cursor page.

Page Delete Deletes the cursor page.

Format Setting

[Page Setting]

Allows you to change the format setting of the cursor page. (P.133)
[Default Setting]

Set the format to be used when creating a new data list or inserting a

page.

B [View] menu

Data Toolbar

Shows or hides the data toolbar.

Send Toolbar

Switches between showing and hiding the send toolbar.

Edit Toolbar Switches between showing and hiding the edit toolbar.
Status Bar Switches between showing and hiding the status bar.
Preview Switches between showing and hiding the preview area.

B [Help] menu

Help

Displays the help menu.

About

Displays the version information.
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The toolbar displays frequently used menus as buttons.

Data Toolbar

(New) Creates a new data list. (P.125)

= Open an existing file or CSV file to load data. (P.126)
(Open)
(Save) Overwrite and save the data currently being edited. (P.131)

Send Toolbar

& (Prind)

Print the data currently being edited. (P.138)

Edit Toolbar

(Undo) Invalidates the last operation.

(Redo) Re-enables the operation that was invalidated by "Undo."
(Cut) Cuts the specified text.

(Copy) Copies the specified text.
(Paste) Pastes the cut or copied text.
(Delete) Deletes the specified text.
(Numbering) Automa-tically create pages by ass‘igning consecutive
numbering or letters to a fixed string of characters. (P.136)

‘E (Page Cut) Cuts the specified page.
(Page Copy) Copies the specified page.

T (Page Paste) Pastes the cut or copied page to the front of the specified

= page.

(Page Insert) Inserts a blank page before the cursor page.
(Page Delete) Deletes the cursor page.
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Working with Files

1 click| [ |(New).

@ Or,you can select [New] from the [File] menu.

® Anew file will be created.

LLINOTE

- For more information on entering and editing data, refer to "Input and Edit (P.132)".
-+ The MK Desktop Utility can only launch one window at a time.

- The format setting for new files and additional pages will be based on the values set in the [Format
Setting] - [Default Setting] section of the [Edit] menu. For more information about format setting, refer

to "Configure the Format Setting (P.133)".
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Opening a File

The file formats that can be opened with MK Desktop Utility are as follows.

+ MK Desktop Utility File (*.md5)
For more information, refer to "Opening a File Created with this Software (P.126)".

syusuodwo)
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- Conventional Application File (* md4; *.md3; *.md2; * MTD)
For more information, refer to "Opening a File Created with a Conventional
Application (P.127)".
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- CSVFile (*CSV)
For more information, refer to "Opening a CSV file (P.128)".
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B Opening a File Created with this Software

1 Click| (2| (Open).

aABS/1ULId

® Or, select [Open] from the [File] menu.

o
0 =.
o S
2 Select a file in MK Desktop Utility File (*.md5) and click [Open]. ==
Sz
33
® The specified file will open and be displayed in =
the data list. H = -
= =g
= g3
=R =
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B Opening a File Created with a Conventional Application

1 dick ﬁ (Open).

® Or, select [Open] from the [File] menu.

2 Select "Conventional Application File (*.md4; *.md3; *.md2; *. MTD)" for the

file type.

3 Select a file in the conventional application file (*.md4; *.md3; *.md2; *.MTD)

and click [Open].
® The specified file will open and be displayed in
the data list.

® When the file is opened, a message will be
displayed informing you that the file has been
converted to the new format (md5).
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CQuickaccess
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Foscippe: | 42T

4  Click [OK].

® The specified file will open and be displayed in
the data list.

LLINOTE

/L\. Ot ormat data s ben converted t new format dat.

(=)

- When saving the edited data, save it as an alias using "MK Desktop Utility File (*.md5)" or "CSV File

(*Csv)!" (P131)
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B Openinga CSVfile

When a CSV file is opened in the MK Desktop Utility, it will be loaded into the data list under the
following conditions.

Slusjuod

Row 1: Text data of Tst line

syusuodwo)

Line 1st2nd

File Edit _Format View Help
1st page A,123,1|A,789 - . i
2nd page =—-8,123,2|8,789 Invalid data Row 2:Text data Of 2I’1d |II’1€
3rd page ——G,123,3)C,789 Row 3: Number of continuous
prints
v s
> * Data in the fourth and 3
n:|coli6 100%  Windows (CRLF)  UTF-8 4 L . E
I o nuous subsequent rows is invalid. £
>
=3

. 4

Page 1st Line 2nd Line Continuo _:c_S
1’ 123 1 =)
S~
2 |B 123 2 A
3 |C 123 3 =
4

LLINOTE

« The maximum number of lines that can be read is 10000.
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1 Cdiick|[Z#|(©Open).

Jndwo)
e buisn uLd

® Or, select [Open] from the [File] menu.

z=
ER
7 Select [CSV File (*.CSV)] for the file type. -1
D o
EEEEEEEEEs—
P YL o
il e
- 1%]
e =
= 33
e g
2 S
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e ea— ¢ =1
i (MK Deskiop Utity Fie (" mdS) E
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3 Selectafile in CSV File (*.CSV) and click [Open].

® The specified file will open and be displayed in
the data list. s g =
Q
L
® When you open the file, the "Read Format s '§ E
"
Selection" dialog box will appear. D R
2
—
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4 Set the format, and then click [OK].

® For details on format setting, refer to
"Configure the Format Setting (P.133)".
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LLINOTE

- When "1 Line" is selected for [Lines], the data in the first column of the CSV file will be read. The data in
the second column will not be read.

- When saving the edited data, save it as an alias using "MK Desktop Utility File (*.md5)" or "CSV File
(*.CSV)" (P131)
Functions not supported by this printer are displayed in light gray.
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Load Additional Data

The contents of the specified file can be additionally loaded at the end of the data list being
edited.
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1 Select [Add] from the [File] menu.

7 Select the file to be loaded and click [Open].

® The data of the specified file will be added to T
the end of the data list being edited.
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Saving a File

B To Overwrite and Save the File You Are Editing

syusuodwo)
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1 cick| | save).

® Or, select [Save] from the [File] menu.

® The file will be saved.

LLINOTE

- When saving a new file, the [Save As] dialog box will appear. For details on how to set this up, refer to
"Saving a file as a new name (P.131)" below.
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B Saving afile as a new name

1 Select [Save As] from the [File] menu.

aABS/1ULId

2 Specify [Save in], [File name] and, [Save as type] and then click [Save].

o

0 =.

® Select "MK Desktop Utility File (*.md5)" or "CSV é i

File (*CSV). 53

® The default settings for the save location are as =
follows:

C:/Users/[User Name]/Documents

Flogame: i ~]
e )
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Input and Edit

Enter text in the data list.

syusuodwo)

1 Click (or double-click) on the location where you want to enter text. -
[0}
& Untitled - MK Deskto -ig‘
File(F) Edit(f) View(V) Remote(R) Help(H) g..
I IR F AL T S
Print Media o
‘Orientation Frame SetlLength
Media Size | HoriHor char Noe | Automatic
Smm hd
Selection Send  Page Jotticg

icd 1 | )

Hp3/anduj

2 Enter the text and then press the [Enter] key (or click on another position). o
=3
| >
Selection  Send  Page e IstLine ()
¥ [ il ) | 5
] 7 S
3
. 0=
o S
3 c
Selection  Send Page, 1st Line T &
P () 1 55
] 7 RQ
Q

LLINOTE

- You may not be able to enter text depending on the format setting, such as when a set length is
specified. For more information on format setting, refer to "Configure the Format Setting (P.133)".
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- If you press (Delete) to delete the input, the data will be cleared, but the page itself will not be

deleted. To delete a page, click .E (Page Delete).
- The font used in the preview of the MK Desktop Utility is different from the font of the printer, so the

font style may differ between the preview and the printed result.
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Configure the Format Setting

Change the character size, number of lines, and other format setting.

1 Open the file. (P.126)

syusuodwo)

2 Select the print media and media size to specify the set length.

® Since the range of set length that can be

CX N NMEEEE
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specified varies depending on the print media, (== “[=2 = = = = &
set the "Print Media" before format setting (Step =%z
3). L
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3 Select the page to change the format in the data list.

® To select multiple pages, do one of the
following.
- When selecting multiple pages in a row:

aABS/1ULId

Click on the start point to select it, then click
on the end point while holding down the

JaIndwo)
e buisn uLg

[rT———

[Shift] key on your keyboard. Release the [Shift]

key when you are done.

- To select multiple, non-contiguous pages:
Hold down the [Ctrl] key on your keyboard as

SBUIIAS Jajug
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you select pages. When you are done, release
the [Ctrl] key.
- You can select all pages by clicking on the

header line.
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Click | =eting... | (Setting).
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® Or, from the [Edit] menu, select [Format
Setting], then [Page Setting].

@ Format setting can also be selected from the
menu that appears by right-clicking on the
data list.

syusuodwo)

Set each item.
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[Orientation]

® The orientation (Vert/Hor) and text direction (Vert char/Hor char) are specified in the
"Orientation” settings. The default setting is "Hor/Hor char!"

® For printimage, refer to "Specifying the Orientation and Character Direction
(P46)".
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[Frame]

® This allows you to surround text with a frame. The default setting of "None"

bunooys
-3|qnoJ|.

[Set Length]

® You can specify the length of one tube (or one label). The default setting is
"Automatic.'

® When "Specify" is selected, the length can be entered in the range of
8 mmto 150 mm (4 mm to 150 mm for labels only) in 0.1 mm increments.

Xipuaddy
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[Alignment]

SUEIlop)

® [fyou set the set length to "Specify, you can change the alignment. The default
setting for alignment is set to "Centered!

® For print image, refer to "Specify the Cut Length and Alignment (P.56)".

syusuodwo)
JO sauweN

[Character Size]

® Sets the character size. The default setting is "3 mm Norm."

® When printing from the MK Desktop Utility, the character size cannot be set to =5
wv

"7.3 mm Norm" = g

[Character Space] =

® Sets the space between characters. The default setting is "Narrow."

[Lines]
® Sets the number of lines. The default setting is "1 Line"

up3/Andu

[Continuous]
® [f you want to set up repeat printing for a page, enter the number of times. The value
can be setin the range of 1 to 200 (times).

LLINOTE

- When the set length is specified, the settings for character size, frame, and character space may not be

aABS/1ULId

able to be changed.

+ When the print media is a label, if the set length is "less than 8.0 mm", "Rule configuration" (Centered)

Jndwo)
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is applied and the setting cannot be changed.
- Functions not supported by this printer are displayed in light gray.

6 Click [OK].
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® When you click [OK], the format setting are
confirmed, and the settings are reflected in the
preview area.
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- The settings for [Continuous] (continuous print) are not reflected in the display of the preview area.
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Automatically create pages by assigning consecutive numbering or letters to a fixed string of
characters. The possible numbering settings are as follows.

Setting Set range
Decimal 010 999
Hexadecimal 0to FFF
Upper case letter AtoZ
Lower case letter atoz

[Example] Create a page for "Pump Room 1" to "Pump Room 10"

1 Enter "Pump Room

Selection Send  Page 1ct lina

e Pune_Roonl
[T =

® Move the cursor to the position where you
want to enter the numbering.

® [facellis set while selected, the number will
be entered at the end of the text.

2 Click| Ho. [(Numbering).

® Or, select [Numbering] from the [Edit] menu. Numbering

)
0 =
g =
3c

wv
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Mode

Start value 3
End value 3

Padding Character ~
LLINOTE
- If not even a single character can be entered when the set MK Desktop Utility

length is specified, a message will be displayed. Change the

. Length exceeded.
format setting. (P.133) I\ Input data exceeds set length.
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3 Seteach item.

® |n this section, we will use the following Numbering

settings.

. Mode Decmal w
Mode: Decimal
Start value: 1 Start value
End value: 10 End value
Padding Character: None Padding Character

cance

LLINOTE

If you want to set numbering in descending order, such as "10 to 1," enter "10" for the "Start value" and
"1" for the "End value!'

- The settings for padding characters are as follows.

Setting Details

None No padding characters.

Zero Aleading "0" will be entered as a padding character.

Space | Aleading space will be entered as a padding character.

If all the digits of the numbering are the same, or if an alphabetic character is selected for the
numbering, "Padding Character" will be grayed out and cannot be set.

- When the set length is specified, the input of the start and end values may be restricted. If the value
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you want to enter cannot be set, change the format setting. (P.133)

4 Click [OK].
. Selection Send Page 1st Line

® A page with a number entered at the end of = o (o
. . d 2| |Pump Roon2
the text is automatically created. v 3| pune Roona
v 4| |Pump Room4
v 5| Pump Roon5
v G| [Pump Roong
v 7| Pump Roou?
I &| [Pump Roong
v 9| Pump Roond
¥ 10} |Pump Roomid

] 11

LLINOTE

If you want to cancel the operation immediately after numbering, click (Undo).
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Print

After entering text and creating a data list, start printing.

1 Connect the printer to the PC with a USB cable, and switch the printer to PC

connection mode. (P.118)

® Confirm that "Waiting for data.." appears on PC Connect

the printer's display. W for
aiting for data...

2 Click [Select printer] on the [File] menu.

(“) IMPORTANT

- If the message is displayed, the printer driver installation
has not been completed. Follow steps 15 through 19in
"Installing the Software (P.113)""

Data cannot be sent to the printer because the printer driver is
I\ nctinstatiea.
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- Ifthe same error occurs again, reinstall the printer driver.
(P.108)

3 Select the printer to be used for printing from the [Select printer] drop-down
list.

® The drop-down list will show a list of printer
drivers installed in your environment.

Seta printer o use.

verifying th the printer.
At the time of changing a printer to use, open this DIALOG from a menu and
setit,

Select printer ( | canon Ma000 v\)

[ ==

4 If you are printing data stored on your computer, open the file. (P.126)
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5 Select the print media and media size.

® When you change the print media and media
size, the settings will be reflected in the

preview area display.
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LLINOTE

- Except for labels, the minimum set length is 8 mm. If there
are pages of 8 mm or less in the data list and the print media
is changed to one other than label, a message to change
the set length to 8 mm will be displayed.

Juoneledaid

If you set print media except for label and plate, the minimum
value of [Set Length] becomes 8.0 mm.
Do you want to change print media?

CET [ w ]

up3/Andu

If the print area is exceeded, the message "Exceeding the print area" will be displayed in the preview
area. Change the print media or change the format setting. (P.133)

- If you want to set a tube that is not on the list of media sizes, refer to "Tube Size Selection
(Recommended) (P.75)".

bunooys SBUINAS Jaulg Jndwo)
/3DURUIUIRI e buIsn ulid SAeS/AUld

-3|gnoJy

Xipuaddy

139



Slusjuod

6 Place a check mark in the [Send] box of the page you want to print.

® To add or remove check marks from multiple [ ssecon( serd page 1ot lne
pages at once, make the settings from [Send > Eons oo
page selection] in the [Edit] menu. To select - -

G2
pages, do one of the following.

03
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- When selecting multiple pages in a row:
Click on the start point to select it, then click
on the end point while holding down [Shift]
on your keyboard. When you are done, release
[Shift].

-To select multiple, non-contiguous pages:
Hold down [Ctrl] on the keyboard while
selecting pages. Release [Ctrl] when you are
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done.
- You can select all pages by clicking on the

header line.

aABS/1ULId

® You can also select [Send page selection] from
the menu that appears when you right-click on
the data list.

Jndwo)
e buisn uLd

7 click & | (Print).

® Or, select [Print] from the [File] menu.
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(“) IMPORTANT

- If the message is displayed, the printer to use is not
selected. Select the printer from [Select printer] on the [File]
menu. (P138) 8 Please choose a printer to use.
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8  Specify the transfer mode.

® Select either [Overwrite internal memory] or
[Add to internal memory] as the transfer mode.
The data just sent to the printer will be retained

on the printer’s character input display even

after printing (or saving) is completed.
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[Overwrite internal memory]
Select this option when you want to print the

page you selected in step 6.
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[Add to internal memory]
Select this option when you want to add the [Example]

data you entered in step 6 to the data stored in
the printer and print it. The additional data will

be added after the last page of the data in the

printer.

SUEIlop)
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(Coon) J ()
ABC 200V
(Page 1) (Page 2)
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LLINOTE

- Functions not supported by this printer are displayed in light gray.

- The numbering part is converted to the control character [Example]

Jndwo)
e buisn uLd

of the numbering (N) and sent to the printer as a single
page of data. Pump Roomil

Pump Room N
(Page 1)
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O lick [OK].

® After the data is created on the printer's
character input display as per the transfer
mode used, printing will begin. Also, the data
on the character input display will be retained
after printing is completed.

LLINOTE

If the message "Unable to open printer" appears, confirm MK Desktop Utility
the following.
- The printer is turned on and the computer is connected D\ Unable to open printer
to the printer with a USB cable. :
- The printer is selected correctly. (P.138) . -
If the message "Could not receive data from printer." MK Desktop Litility
appears, the printer has not switched to the PC connection
mode. Switch the printer to PC connection mode. (P.138) [\ Could not receive data from printer
-
N =
o >
| 52
If you try to save a file with the same name as a file that has XXXXXXXX % Z
already been saved, the following message will appear on already exists. =@
the printer display. If you want to overwrite the file, click [Yes]. Overwrite?
No

- The font used in the preview of the MK Desktop Utility is different from the font of the printer, so the

font style may differ between the preview and the printed result.
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View the Status Monitor

The status monitor starts automatically when printing starts and displays the printer status and
remaining ink ribbon level.

View Settings for the Status Monitor

Set to show or hide the status monitor. The default setting is "Use the Status Monitor."

1 select [Start] > [Windows System Tools] > [Control Panel] > [Hardware and

Sound] > [Devices and Printers].

® ForWindows 11
Select [Start] > [All apps] > [Windows Tools] > [Control Panel] > [Hardware and Sound]
> [Devices and Printers].

® ForWindows 8.1
From the desktop charm, select [Settings] > [Control Panel] > [Hardware and Sound]
> [Devices and Printers].

Right-click the printer icon, and select [Printing Preferences].
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Click the [Status Monitor] tab.

Select [Use the Status Monitor] or [Not use the Status Monitor], and then click [OK].

!;! ‘Canon MK2000Printing Preferences

Page Graphics Ststus Monitor

Status Monitor

@ ise ritor:
() Not use the Status Monitor

Co= 1) e | [

(“) IMPORTANT

-+ When printing from the MK Desktop Utility, do not change the print settings in the Page Setup and
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Graphics sheets. Any changes to the settings will not be reflected in the printing from the MK Desktop
Utility.

LLINOTE

« Click [Version..] to check the printer driver version, copyright, and other information.
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'Status: Printineg.. ; n

(R.t.bon type:: Black 15am)
(Ribbon remainine: I ) —

Status Displays a message informing you of the current printer status.

Ribbon type Displays the type of ribbon cassette. There are three types: "White 85m,"
"Black 150m," and "Black 40m compatible with plate."

Ribbon Displays the approximate remaining amount of ink ribbon. (There
remaining may be a slight difference from the actual remaining amount.) If the
remaining amount is not read correctly, the remaining amount is not
displayed.

The printer status is displayed in four images.

Indicates that the printer is in a normal state.
o Indicates that the printer is online and can print.

Ribbon type: Black 150m

Ribbon remainine: |

O
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Indicates that the printer is offline.

Indicates that a warning has occurred.
Status: Printing.{Low ribbon level) H B B H
e A warning message is displayed in the [Status]
Rbbon remainie. | field, but you can continue printing. Take action as

necessary.

Indicates that an error has occurred.
e L ey An error message is displayed in [Status], and

| | Ribbon type: Black 150m

Riton ensiris printing cannot be performed.
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List of Message

If a problem occurs while connected to the printer, an error message or warning message will be

displayed on the status monitor. Read the message, and follow the corresponding procedure.

Message

Solution

Low ribbon level

The ribbon is running low. Prepare a new ribbon cassette.

Low battery level

For more information, refer to "Battery is running low. (P.183)".

No Media For more information, refer to "Print media isn't set. (P.181)".
End of Media For more information, refer to "End of media. (P.181)".
End of Ribbon For more information, refer to "End of ribbon. (P.182)".

No ribbon cassette

For more information, refer to "Ribbon cassette isn't set.
(P.181)".

Media JAM

For more information, refer to "Feed error (P.183)".

Cover is Open

You cannot print with the cover open. Close the cover and press
any key.

Check of the size switch
lever

For more information, refer to "Size switch lever is not
positioned correctly. Proceed? (P.182)".

Cutter Initialization
Error

Head initialization error

Head print position
error

Press any key. If the same message appears again, contact your
place of purchase.

Warmer temperature
rise delay error

Warmer abnormal
temperature error

Turn off the printer and set the warmer again. (P.31)
If the same message appears again, contact your place of
purchase.
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Chapter 5

Maintenance/Printer Settings
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Cleaning the Printer

Cleaning the Qutside of the Printer

Wipe the surface of the printer periodically to keep it clean.

syusuodwo)
JO sauweN

dniag
Juoneiedald

=)
o

c

—t
S~
m
o}
=

1 Turn off the power and unplug the power plug from the power outlet.

® [f batteries are being used, remove them.

SABS/1ULId

2 Wipe the surface of the printer.

® Wipe the printer with a cloth moistened with water and wrung out tightly. Use a lint-free
cloth.

J9Indwo)
e buisn g

® Allow the water to dry completely before proceeding to the next step.

3 Insert the power plug into the outlet and turn on the power.
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Cleaning the Inside of the Printer

If the inside of the printer is dirty, the print media may become dirty or dust may enter the unit,
causing printing defects. Wipe it regularly to keep it clean.
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- Remove the cutter before cleaning the area around the cutter and media delivery
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1 Turn off the power and unplug the power plug from the power outlet.

@ [f batteries are being used, remove them.

J9Indwo)
e buisn g

2 Open the cover and remove the ribbon cassette, attachment (or label tape

cassette), and cutter.
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3 Wipe the inside of the printer.

® Wipe the printer with a cloth moistened with water and wrung out tightly. Use a lint-

free cloth.
® Allow the water to dry completely before proceeding to the next step.

@ IMPORTANT

Do not touch the ink ribbon connector, print
head, or connector for tube warmer inside the
printer. Doing so may result in malfunction of
the product.

e ——

— Connector for

tube warmer

Print head

Connector for
ribbon cassette

4 When you have finished cleaning, return the cutter to its original position and

close the cover.
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Cleaning the Transport Roller

If printing is not clear or the print media cannot be fed properly, the transport roller may be dirty.
We recommend cleaning the rollers about once a month.

Open the cover and remove the ribbon cassette, and attachment (or label

tape cassette).

N

Close the cover, and then press the [Option] key.

w

Use [a] or [¥] to select "Others," and then press the [Enter] key.

Option
Print adjust

Setting

Use [A] or [w] to select "Cleaning," and press the [Enter] key.

® After pressing a key, instructions will be
displayed on the screen.

152

Others
Remove

Forced full cut

A

v

.

Cleaning mode

Open safety cover

and remove dust.
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5 Open the cover.

® \When the cover is opened, instructions will
be displayed on the screen.

Cleaning mode

After cleaning,
close safety cover.

6 Wipe off any dirt on the transport roller 1, 2 and 3 with a cloth moistened with
water and wrung out tightly.
® Transport roller 3 is cleaned by pushing the

jam recovery lever in the direction of the
arrow.

® Use a lint-free cloth.

7 Close the cover.

® The transport roller will spin.

sBuINIaS Ja3ug
/3DURUDIUIRI

8 Repeat steps 5to 7.

® Open and close the cover 8 times to make one rotation of the roller.

9 When cleaning is finished, press the [Shift] + [Cancel] keys.

® The display returns to the character input display.
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Cleaning the Print Head

If printing is not clear or white streaks appear, the print head may be dirty. We recommend
cleaning the print head about once a month.

syusuodwo)

Juoneledaid

1 Turn off the power and unplug the power plug from the power outlet.
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® |[f batteries are being used, remove them.

Open the cover and remove the ribbon cassette, and attachment (or label

N

tape cassette).

SABS/1ULId

Wipe off any dirt on the print head with a cotton swab moistened with water

w

d ightl o3

and wrung out tightly. 52
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(¥) IMPORTANT g3
25

- Do not touch the print head directly. Doing so may result in malfunction of the product. 3a°®

4 When cleaning is finished, close the cover.
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Cleaning/Replacing the Cleaners

The tube attachment, (optional) tube warmer, and (optional) plate and flat tube attachment are
equipped with a cleaner to remove dirt from the surface of the print media.

Remove the cleaner as shown in the figure, and then remove the dirt from the sponge. If the
sponge is damaged, replace the entire cleaner.
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(“) IMPORTANT

Dispose the used cleaner according to local government regulation.
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Replacing the Cutter

If the tube or label tape does not cut properly even after adjusting the depth and motion of the
cutter, replace the cutter. Also, when replacing the cutter, replace the blade receiver at the same
time.

A cauTioN

. The cutter is designed so that it cannot be touched directly, but if it is handled
improperly, the blade may pop out and cause injury. Never perform any operation
that is not described in this manual.

- Do not leave replaced parts unattended. If they come into contact with the hands of
children, they may cause injury.

« When replacing the cutter, be sure to turn off the power.

(¥) IMPORTANT

Itis best to replace the cutter after about every 50,000 cuts. (When using PVC tube with an inner
diameter of 3.2 mm)

- Dispose the removed cutter and blade receiver according to local government regulation.

LLINOTE

- The Mounted Cutter Count is counted regardless of the print media being used. Also, any cutter
operations performed while printing with the cutter removed will also be counted in the Mounted
Cutter Count.
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1 Turn off the power. (P.17)

7 Open the cover.
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3 Remove the cutter.
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4 Insert the new cutter.

@ Paying attention to its orientation, insert the
new cutter until it hits the back of the cutter bay.
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5 Remove the blade receiver.
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6 Insert the new blade receiver.
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7 Close the cover.
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8 Turn on the power. (P.15)
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9 Press the [Option] key.
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10 Use [a] or [w] to select "Others," and then press the [Enter] key.

Option
Print adjust A

Setting

v

11 Use[a]or [w] to select "Counter," and then press the [Enter] key.

Others
Init. DeleteCheck A

Page Display
Counte MMM

12 Record the Mounted Cutter Count, and then press the [Enter] key.

® We recommend that you record the Mounted Mounted Cutter Count
Cutter Count in the "Cutter Operation Record" 50000 times

in the Basic Operation Guide included with the Total Feed Length
10000 m

product each time you change cutters.

13 Use [a] or [¥] to select "Replace cutter” and press the [Enter] key.

® After the following screen is displayed, the (Others
display will return to the previous screen. Forced full cut A

® The mounted cutter count will be reset to "0". Feed
Replace cutterih4

® The depth and motion of the cut will return to

"Normal". '

Cutter replacement
is accepted.
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14 Press [Shift] + [Cancel] keys.

® The display returns to the character input
display.
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Changing the Printer Settings

Changing the Auto Power Off Settings (Adapter/Battery)

Change the amount of time that the unit will automatically turn off after a certain period of
inactivity. The auto power off setting can be set for each power source used, and the default

setting for both is "30 min."

1 Press the [Option] key.

2 Use[a]or [¥] to select "Others" and press the [Enter] key.

Option
Print adjust A

v

3 Use [a] or [¥] to select "AutoOff (adapter)" (or "AutoOff (battery)"), and then

press the [Enter] key.

Others

Replace cutter A
AutoOff (adapter)

AutoOff (battery) W

4 Use [a] or [w] to select the time until the power is automatically turned off,

and then press the [Enter] key.

® You can select the timer setting from "No," "5
min.""15 min."and "30 min."

160

Auto Off (Adapter)
5 min. A

30 min. v
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5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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(“) IMPORTANT

- In the following cases, the automatic power off function will not work.

- When an error has occurred.

Juoneiedald

- When the cover is open.
- The time will be reset when you switch the power source used.
If the set time elapses without receiving data while connected to a PC, the power will automatically

turn off.
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Changing the Display Settings

You can change the contrast and brightness of the display.

B Adjusting the Display Contrast

The default setting of the display contrast is set to "5."

1 Press the [Option] key.

2 Use [a] or [¥] to select "Setting," and press the [Enter] key.

Option
Print adjust A
Others

3 Select "Display contrast" with [a] or [w] and press the [Enter] key.

Setting

Print speed A
Display contrast

Backlight (ADPTR) W

4 Select the contrast by [¢] or [ ] and press the [Enter] key.

o A A mark will be displayed under the current Display contrast
setting. Lligt'lt L [I)arlk
® Display Contrast can be set in the range of 1 L i L

(lightest) to 9 (darkest).

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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B Adjusting the Brightness of the Backlight (Adapter/Battery)

The backlight brightness can be set for each power source used, with the default setting being
"4" when using the AC adapter and "1" when using batteries.

1 Press the [Option] key.

7 Use[a]or[¥]to select "Setting," and press the [Enter] key.

Option
Print adjust A
Others

3 Use [a] or [w] to select "Backlight (ADPTR)" (or "Backlight (BAT)") and press
the [Enter] key.

Setting

Display contrast A
Backlight (ADPTR)

Backlight (BAT) W

4 Select the brightness by [4] or [ p] and press the [Enter] key.

o A" A" markwill be displayed under the current Backlight (Adapter)
setting.
® The backlight brightness can be set in the range 12 1

of 1 (darkest) to 4 (brightest).
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5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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B Changing the Automatic Backlight Off Setting

Change the time for the display backlight to automatically turn off after a certain period of
inactivity. The default setting is "5 min.'

1 Press the [Option] key.

2 Use[a]or[¥]to select "Others," and then press the [Enter] key.

Option
Print adjust A

3 Use [a] or [w] to select "AutoBacklightOff" and press the [Enter] key.

v

Others
AutoOff (adapter) A

AutoOff (battery)
AutoBacklightOff \ 4

4 Use [a] or [w] to select the time until the backlight turns off automatically,

and then press the [Enter] key.

® You can select "No," "1 min." "3 min." or "5 min. Auto Backlight Off
1 min.

5 min. v

2=
=Y
= =-
=3
v B
JeaY]
= =5
=
R

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.

(¥) IMPORTANT

- Ifthe set time elapses without receiving data while connected to a PC, the backlight will automatically
turn off.
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Turning Off Sounds

Turns off the key operation sounds and warning sounds. The default setting for the sound is "On"

1 Press the [Option] key.

2 Use [a] or [w] to select "Setting," and press the [Enter] key.

Option
Print adjust A
Others

3 Use[a]or [w] to select "Sound," and then press the [Enter] key.

Setting
Backlight (ADPTR) A

Backlight (BAT)
Sound] v

4 Use [a] or [w] to select "Off" and press the [Enter] key.

Sound

M On

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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Initializing this Printer

Restores all settings to their original settings. (Initializes the printer)

(“) IMPORTANT

« The all current data and saved files will be erased when initialized. Erased data and files cannot be

restored.

1 Tum off the power. (P.17)

2 While pressing the [Delete] key, press and hold the power key for at least one

second.

® A confirmation screen for initialization will
appear.

3 Select "Yes" with [q] or [p] and press the [Enter] key.

® After "Resetting.." is displayed, the power will
turn off.

166

Reset all settings ?

Yes No
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Chapter 6

Troubleshooting

If a Tube or Label Tape Becomes Jammed

What to Do in Case of Trouble

A Message is Coming Up

Updating the Firmware

Checking the Firmware Version

Running the Firmware Update
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if a Tube or Label Tape Becomes
Jammed

If the print media gets jammed inside the printer, a "Feed error" message will be displayed on the
display and printing will be canceled. Follow the procedure below to remove the print media.

Feed error

Media is jammed in
the feeding path. ¥

LLINOTE

- Ifthe print media is jammed inside the printer but the message is not displayed, press and hold the

[Cancel] key for 2 seconds or more to stop printing, and then follow the instructions starting from
step 2 to remove the print media. (In this case, the messages shown in the steps below will not be
displayed.

1 After reading the "Feed error" message, press any key.

® |Instructions will be displayed on the screen.
Open the cover.

2 Open the cover.

® \When the cover is opened, instructions will
be displayed on the screen.
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Remove the ribbon
cassette.

v
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3 Remove the ribbon cassette.

@ |[fthe ribbon is wound around the cassette
and cannot be removed, do not remove it
forcibly, and proceed to step 4.

4 Press any key.

® After pressing a key, instructions will be While pushing the

displayed on the screen Jam recovery lever,
play ' remove print media

in the printer. v

5 (When using tube)
As shown in the figure, pull the tube out while pressing the jam recovery
lever in the direction of the arrow.

® [fthe tube cannot be pulled out, remove the >//f%/

attachment while pressing the jam recovery

lever in the direction of the arrow.

® |[fthe ribbon cassette has not been removed
in the previous step, remove the ribbon
cassette.

(When using a label tape)
Remove the cassette while pressing the jam recovery lever in the direction
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of the arrow, as shown in the figure.

® |[fthe ribbon cassette has not been removed
in the previous step, remove the ribbon
cassette.
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6 After removing the print media (or cassette), press any key.

® After pressing a key, instructions will be Set the ribbon
displayed on the screen. cassette and close
the cover.

7 Remove any slack in the ribbon.

(¥) IMPORTANT

- Ifthe ribbon is loose, it may not operate properly.

8 Replace the ribbon cassette and close the cover.

® Insert the ribbon cassette straight in, and
press firmly until it clicks into place.

® When the cover is closed, a confirmation
screen will be displayed.

9 When the print media has been removed, use [4] or [ p] to select "Yes" and
press the [Enter] key.

5
o O
® The display returns to the character input Can the print media 2 &
. - >
display. in the media path be a ?
?
@ [fyou select "No' a "Feed Error" message will remo. No

be displayed again. Follow the procedure
from step 1 to completely remove the print
media.
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10 Cut out the bent or damaged portion of the jammed print media or the
printed portion of the print media if it exists.

11 Reload the print media. (P.21)

[LLINOTE

« Using the feed function to remove the print media
If the tube or label tape is in a position where it cannot be removed by hand, use the feed function.
However, if you continue to feed with the feed function, it may damage the print media or the
ribbon in the ribbon cassette might get rolled up, causing it to jam. Only use this function in

extenuating circumstances.

1 Pressthe [Option] key.

2 Usela]or[¥]to select "Others," and then press the [Enter] key.

Option
Print adjust A

3 Select "Feed" with [a] or [w] and press the [Enter] key.

Others
Forced fullcut A
Replace cutter VW
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4  Use [4] (Forward) or [P] (Reverse) to feed the print media to the

desired position.

® Aslong asyou keep pressing [ ]
or [ p], it will be fed forward or
backward continuously.

Feed

Forward: []
Reverse: [p]

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character
input display.
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What to Do in Case of Trouble

Problem

Cause/Things to Check

Solution

The power does not turn
on.

Check that the AC adapter
and power cord are properly
connected.

After confirming that the AC
adapter and power cord are
connected, insert the power
plug firmly into the power
outlet.

Are you using the supplied AC
adapter (PR-TP001) and power
cord?

Do not use anything other than
the supplied AC adapter (PR-
TP0O01) and power cord. Failure
to do so may result in fire,
electric shock, or malfunction.

Are the batteries installed in
the wrong direction?

Make sure that all batteries

are installed correctly in the
direction marked on the inside
of the battery case.

Are the batteries low?

Replace the batteries or use the
included AC adapter (PR-TP0O1).

Are batteries other than the
specified ones being used?

Use the specified batteries.
(P13)

The display does not
change to the AC adapter
symbol even after the AC
adapter is loaded.

Check that the AC adapter
and power cord are properly
connected.

Turn off the power, make sure
the AC adapter and power cord
are connected, and then insert
the power plug firmly into the
power outlet.

The remaining battery
charge is not displayed
correctly.

If you load batteries that

are not fully charged, the
remaining battery charge may
not be displayed correctly.

Use fully charged batteries.
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Problem

Cause/Things to Check

Solution

The device does not print
clearly.

The printing is
misaligned.

The printing is missing or
blurred.

Is the type and size of the print
media selected in the print
settings the same as the print
media actually loaded?

Check the loaded print media
and set the print media type
and size correctly.

Is the ribbon cassette loaded
correctly?

Remove the ribbon cassette,
remove any slack, and then
reinsertit. (P.19)

s the attachment or label
cassette loaded correctly?

Remove the attachment or
label cassette, and reload it.
(P.21)

Is the tube twisted or warped?

Correct any twists or warps
before loading. (P.23)

If the end of the tube is bent
due to winding or other
reasons, straighten it out or
cut off the bent portion before
loading it into the printer.

Is the print media deformed?

Cut off the deformed part of
the print media and reinsert it.

Is the tube dirty?

Wipe off any dirt or dust with a
dry cloth. Also, do not use tubes
that have oil or other stains that
cannot be wiped off.

s there any load on the tube
transport?

Place the printer and the print
media on the same table (or at
the same vertical position) so
that no load is applied to the
transport.

When using a tube reel, lighten
the load.

174

(%)
>
]
(]
=2
=
(o]

-3|gnoJy




(Continued from previous
page)

The device does not print
clearly.

The printing is
misaligned.

The printing is missing or
blurred.

No error message will be
displayed even if the print data
extends beyond the width of
the print media.

Refer to "Maximum Printable
Character Size (P.44)"

for information on setting the
character size and frame. It is
recommended to refer to the
preview to make sure that no
characters are missing before
printing.

Try to fine-tune the print
position in the vertical direction.
(P.82)

Change the settings for
character size, frame, and
number of lines.

Are the print density and print
speed appropriate?

Adjust the print density to be
darker. (P.86) Slow down the
print speed. (P.87)

Are the transport rollers dirty?

Clean the transport rollers. We
recommend cleaning the rollers
about once a month. (P.152)

Is the print head dirty?

Clean the print head. We
recommend cleaning the print
head about once a month.
(P.154)

Is the cleaner of the
attachment or (optional) tube
warmer dirty?

Clean the cleaner. We
recommend cleaning the
cleaner about once a month.
(P.155)

If the cleaner is worn out,
replace it with a new cleaner.

Is the inside of the printer dirty?

Clean the inside of the printer.
(P.150)
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(Continued from previous
page)

The device does not print
clearly.

The printing is
misaligned.

The printing is missing or
blurred.

Is the operating environment
appropriate?

For information concerning the
operating environment, refer to
"Specifications (P.189)".

If you use a tube warmer
(optional), you can print at
external temperatures as low as
5°C (41°F).

If the problem is not solved by
using the tube warmer

Set the temperature of the tube
warmer to "High!" (P.35)

The parts of the tube that do
not pass through the tube
warmer (such as the top
portion of the tube) will not be
warmed up. Check the printout
on a warmed area.
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Problem

Cause/Things to Check

Solution

Characters are squashed
or blurred.

Are you printing small or
complicated characters?

Adjust the print density.
(P.86)

The surface of the print
media is dirty after
printing.

Ink may stick to the ribbon due
to the top of the print media
touching the ribbon during
printing.

Use a dry cloth to wipe off any
dirt on the print media.

Out of ribbon

There is a sticky stain on the
tube that looks like the glue
from plastic tape.

Use a clean tube.
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Problem

Cause/Things to Check

Solution

The print media cannot
be fed properly.

Is there any load on the tube
transport?

Place the printer and the print
media on the same table (or at
the same vertical position) so
that no load is applied to the
transport.

When using a tube reel, lighten
the load.

Are the transport rollers dirty?

Clean the transport rollers.
We recommend cleaning the
rollers about once a month.
(P152)

The tube may not be fed
properly due to deformation of
the part that was pinched by
the transfer roller.

Cut off the deformed part and
reload the print media.

After printing, remove the

print media from the printer

to prevent warping or
deformation of the print media.

Is there glue on the media
delivery port of the label tape?

Check to see if glue is sticking
to the media delivery port of
the label tape. (P.25)

If glue is adhered to the media
delivery port of the label tape,
the label tape may become
stuck.

Is the operating environment
appropriate?

For information concerning the
operating environment, refer
to "Specifications (P.189)".

If you use a tube warmer
(optional), you can print at
external temperatures as low
as 5°C (41°F).
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Problem

Cause/Things to Check

Solution

The device cannot make
full cuts.

The device cannot make
half cuts.

Half cuts are cut too
deep.

Are the cutter and blade
receiver set correctly?

Refer to "Replacing the
Cutter (P.156)" for
information on how to set
the cutter and blade receiver
correctly.

Are the depth and motion of
the cut appropriate?

Please adjust the depth
(P.91) and motion (P.96)
of the cutter.

Is it time to replace the cutter?

Replace the cutter and blade
receiver. (P.156)

The cutting position is
off.

The printed area gets cut.

The tube is cut at an
angle.

Are there any objects around
the media delivery port that
prevent the media from being
ejected?

Do not place any objects around
the media delivery port. If there
is an object blocking the outlet,
the tube or label tape may not
be ejected straight and may be
cutin a bent shape.

Is there any load on the tube
transport?

Place the printer and the print
media on the same table (or at
the same vertical position) so
that no load is applied to the
transport.

When using a tube reel, lighten
the load.

Is the tube twisted or warped?

Correct any twists or warps
before loading. (P.23)

If the end of the tube is bent
due to winding or other
reasons, straighten it out or
cut off the bent portion before
loading it into the printer.

Depending on your print
media and environment, the
print position may be shifted or
the length of one tube (or one
label) may be different from
the setting.

Make fine adjustments to the
print position and cut length.
(P.80)

If the problem is not corrected
by using the length adjust, set
the half cut to "Off" and cut
with scissors.
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A Message is Coming Up

If a problem occurs during operation of or printing using product, an error message will be
displayed on the display. Read the message, and follow the corresponding procedure.

Message

Details/Solution

Input value is out of the
acceptable range.

Enter a value within the setting range.

No data to paste.

Cut or copy the page and prepare the data to be pasted.

Exceeding Memory
Capacity.

No more characters can be
entered.

There is insufficient memory to input text. (P.189) Save the
text data you have created, delete all text displayed on the
screen, and then enter new text.

Length exceeded.

Input data exceeds cut
length.

Enter a value within the setting range.

Numbering is already set
for this page.

The numbering can be set only once per page.

Exceeded character limit.

Rework the file so that it fits within the number of character
that can be entered.

XXXXXXXX
already exists.

Change the folder name.

Use a different folder name.

Exceeding Memory
Capacity.

Excessive data are not
saved.

There is insufficient memory to save the file. Increase the free
space by deleting unnecessary files.

No files.

There are no files saved in the printer.

No files in selected folder.

None of the files are saved in the selected folder. Select the
folder again.
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Message

Details/Solution

99 files already exists in
selected folder.

1 A maximum of 99 files can be saved in one folder. Delete
unnecessary files before saving, or save them in a different
folder.

Exceeded character

limit. Cannot change.

The character count limit for the specified cut length has been
exceeded. Change the cut length setting (P.55) or delete
the characters.

Cannot input.

Change length or character
size.

Cannot input text with the specified character size and cut
length. Change the cut length (P.55) or character size
(P43).

Numbering data setting
exists.

The page you are trying to divide or combine has numbering.

Delete the numbering. (P.51)

No character data.

You need to have already entered text in advance to display
the printing preference display. Enter characters before
pressing the [Print] key.

Data beyond cut length will
be deleted. OK?

When "Yes" is selected, data exceeding the cut length will be
deleted automatically.

If you select "No," the deletion will be canceled. Change the
cut length or the number of characters.

Close cover and press any
key.

You cannot print with the cover open. Close the cover and
press any key.

Print media isn't set.

Reload the print media correctly. Press the [Enter] key to start
printing. (P.21)

Depending on the type of tube, the tube may not be
detected. In this case, set the print media to "Clear Tube" in
the print settings and print. (P.72)

Ribbon cassette isn't set.

Load the ribbon cassette. Press the [Enter] key to resume
printing. (P.18)

End of media.

Pull out print media

The print media ran out during printing. Pull out the print
media from the printer and press any key. Replace the print
media with a new one and press the [Enter] key to resume
printing from the interrupted page. (P.21)
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Message

Details/Solution

Replace print media.

Load a new print media and press the [Enter] key to resume
printing. (P.21)

End of ribbon.

Replace ribbon cassette.

Replace the ribbon cassette with a new one and press the
[Enter] key to resume printing from the interrupted page.

Print head position can't be

initialized.

Print head can’t be moved to

print position.

Cut position can’t be
initialized.

Press any key. If the same message appears again, contact
your place of purchase.

Size switch lever is not
positioned correctly.
Proceed?

The size of the print media set on the printing preference
display does not match the position of the size switch lever.
(P22)

If you select "Yes," printing will start.

To reset the settings, select "No" and follow the instructions
on the screen to set the size switch lever to the correct
position. Press any key to start printing.

Data check.

Resetting completely

An error has occurred in the data and all settings have
reverted to the settings at the time of purchase. All saved
files have also been deleted.

Power turned off when
saving file.

Checking saved data.

Check the saved files. If the data is not saved, re-save it.

Power turned off when
loading file.

Resetting input data.

The data being entered will be deleted. Re-enter the data.

Power turned off when
deleting file.

Checking saved data.

Check the saved files. If the file has not been deleted, delete
it.
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Message

Details/Solution

Feed error

Media is jammed in the
feeding path.

The print media jammed during printing. Follow the
instructions on the screen to remove the jammed print
media. (P.168)

No ribbon information.
Ribbon remaining amount
can't be displayed.

Information could not be read from the IC chip in the ribbon
cassette. Or, a ribbon cassette that has already been used up
has been loaded.

Press any key and follow the instructions on the screen.

Power cycle the printer.

Turn the power back on. If the same message appears again,
contact your place of purchase.

As warmer temp.

didn't rise enough, warmer
was turned off.

As warmer temp.

couldn’t be controlled,
warmer was turned off.

Turn off the printer, and re-set the tube warmer in place
again. (P.31) If the same message appears again, contact
your place of purchase.

Turn off the printer and
check the AC adapter.

Turn off the power, unplug the AC adapter from the power
outlet, and then contact your place of purchase.

Updating the firmware is
failed. Please try again.

Press any key, and then execute the firmware update file (.exe)
again.

Communication error

Reconnect to host device.

Press any key.
Perform PC connect again to send data.

Battery is running low.

OK to continue?

The battery level is low. If you select "Yes," you can continue
printing. When you have finished printing, turn off the power
once. After that, replace the batteries or connect the AC
adapter.

Wrong cut length
Adjust the length?

When "Yes" is selected, the cut length is automatically
changed according to the print media.

If you select "No," the cut length will not be changed. Change
the cut length or the number of characters.
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SUEIlop)

Exceeding Memory There is insufficient memory to receive text. (P.189)
Capacity. Reduce the number of characters and send the data again.

Reduce the data size and
resend.

syusuodwo)

Loading data exceeds the When a file with text exceeding the cut length is inserted
cut length. into data with a specified cut length, if you load it as "text
only," the characters past the cut length will be deleted, then

The excessive data have i }
the text will be displayed.

been deleted.
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Updating the Firmware

New firmware is released to add new functions or resolve issues with existing functions. It is
recommended that you always use the latest firmware to improve the functionality and ease-of-
use of the printer.

Checking the Firmware Version

Please check the firmware version of this product before updating it.

1 Press the [Option] key.

2 Use[a]or [¥] to select "Others" and press the [Enter] key.

Option
Print adjust A

3 Use [a] or [w] to select "Device Info.," and then press the [Enter] key.

Others
Page Display A
Counter

Device Info.

4 Check the firmware version.

Item Details Device Information
S/N Printer serial number /N~ :XXXXXXXXXX
Main :Ver.XX.XX o
Main Printer firmware version Font :VerXX.XX 33
o C
Font Font version E %
[(o N1

5 Press the [Shift]+[Cancel] keys.

® The display returns to the character input
display.
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Running the Firmware Update

(“) IMPORTANT

Download the latest firmware from the Canon website;
- Usersin the US.A
https://www.usa.canon.com/internet/portal/us/home/support/
- Users in the South & Southeast Asia
https://asia.canon/en/support/download
+ Use the AC adapter when updating the firmware.
- Multiple printers cannot be updated at the same time. Only one printer should be connected at a
time, be it an MK5000 or MK3000 model.
- You must be logged in to the computer as a user with administrator privileges.

- Exitall other running applications.

Connect the AC adapter to the printer. (P.12)

Connect the printer to the computer with the USB cable.

Press the [Option] key.

Use [a] or [w] to select "Others" and press the [Enter] key.

1
2
3 Turnon the printer. (P.15)
4
5

Option
Print adjust A

Setting v

6 Use [A] or [¥] to select "Firmware update" and press the [Enter] key.

Others
Counter A
Device Info

[Firmware update I\4
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https://www.usa.canon.com/internet/portal/us/home/support/
https://asia.canon/en/support/download

7/ Use[a]or[¥] to select "Yes" and press the [Enter] key.

® Ifyou select "Yes" the printer will be on standby Firmware update

state to receive from the firmware update file. No
Yes

b

Please update the
firmware with update
file via PC.

LLINOTE

- If you want to cancel the standby state, turn off the printer.

8 Execute the firmware update file (.exe) on the computer.

® After checking the current firmware version and the version of the updater, click [Send].

® When the update is complete, the printer will automatically turn off.

(¥) IMPORTANT

- Don't do any of the following while updating the firmware.

- Turn off the power.

- Unplug the USB cable.

- Operate any component of the printer.

- Send data to the printer from an application or a printer driver.

- Put/allow the computer to sleep (the update may not be performed properly if the computer goes

into sleep mode.)

If any of the following occurs, the update may not have been performed correctly. Please check the
firmware version on your device.

- The update may have been interrupted in the event of a power outage, etc.

- The "Firmware update complete" dialog box does not appear at least 20 minutes after starting the

update.

9 After confirming that the update is complete, close the firmware update file
screen.

® This completes the firmware update.
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Specifications

Product name MK3000

Printing method Thermal transfer using one-line head
Resolution 300dpi

Printing speed High speed mode: 25 mm/sec

Low speed mode: 18.5 mm/sec

Throughput High speed mode (25 mm/sec):
35 tube segments/min

Low speed mode (18.5 mm/sec):
30 tube segments/min

<Printing conditions>

- Printing media; Tube
- Segment length; 20mm
- Characters to print;
Five "3 mm full-width"
- Half cutting
- Cutting strength; Normal

Cut length Tube: 8 mmto 150 mm
Label tape: 4 mm to 150 mm

Ink ribbon Ribbon cassette
(black: 40 m/150 m, white: 85 m)

Character print size 1.3mm full-width, 2 mm full-width/half-width,
2.6 mm full-width/half-width,

3 mm full-width/half-width,

4 mm full-width/half-width,

6 mm full-width/half-width

Input system Chiclet keyboard

Display system LCD (160 x 64 dots) with backlight

Number of display characters Input data 10 characters x 2 lines (for full-width)

Internal memory Printing character data storage of approximately
5,000 characters

File storage of approximately 250,000 characters
Number of folders: 10

>
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°
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Cutting method Automatic half cut, Automatic full cut
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Power AC adapter
supply (PR-TPOO1)

10010240V 50/60 Hz 0.74 A

Rechargeable battery

eneloop AA Rechargeable Batteries, Standard Model
(Model Number: BK-3MCCA (for North America), BK-
3MCCE (for Asia): 6 pieces

Interface

USB2.0 Full-Speed

Operating environment

Temperature: 15 to 32.5 degrees Celsius *
Humidity: 10% to 85% (no condensation)

*With the tube warmer installed: 5 to 18 degrees
Celsius

Maximum power consumption

24 W

External dimensions

272 mm (W) x 318 mm (D) x 97 mm (H)

Weight

2.7 kg (not including accessories)
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The following print media can be used for printing.

PVC tube 2 1.5 mmto @ 10 mm inside diameter

0.4 mm to 0.6 mm thickness

Clear tube *With the tube warmer installed: @ 1.5 mm to @ 6.5 mm
inside diameter

Tube *1

Heat shrink tube | @ 1.5 mmto @ 10 mm inside diameter
0.2 mm to 0.4 mm thickness

Label tape Cassettes (White, Yellow, Silver) in 6,9 or 12 mm width, 30
m length (Silver: 27 m length)

Flat tube *1*2 2 1.5 mmto @ 6.5 mm inside diameter, 11.2 mm or less
width, 0.4 mm to 0.6 mm thickness

*1 Please purchase commercially available tubes for use. Also, some commercially available tubes
cannot be printed by this printer. Please test the operation on a given print media before use.

*2 The optional plate and flat tube attachment is required.

System Requirements for Software

Compatible OS Windows 11
Windows 10 (64bit/32bit)
Windows 8.1 (64bit/32bit)

Computer A computer that supports any of the above operating
systems.
Monitor and video driver 1024 x 768 dots resolution,

1280 x 1024 recommended.

Free hard disk space required | Application software: 100MB

for installation (including Printer driver: 100MB
temporary file storage) * Disk space requirements are subject to change without
notice.
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Consumable Supplies and Options

Details on consumable supplies and options can be found below.
For details on how to purchase consumable supplies and options, please contact your place of
purchase.

LLINOTE

- Please purchase commercially available tubes for use. For more information, refer to "Print Media
(P.191)".

B Consumable Supplies

@ Ribbon cassette @ Label tape cassette

Black: 40m/150m, Width: 6mm/9mm/12mm
White: 85m Color: White/ Yellow/Silver

@ Cutterset @ Cleaner

*Blue
* For the tube attachment, (optional) plate and flat tube
attachment (used for printing on flat tubes), and (optional) tube

warmer.
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M Options

SUEIlop)

@ Tube Warmer

This device is used to warm up tubes that have become stiff due to cold. The tube warmer

allows for clean printing even in low temperature environments.

syusuodwo)

Juoneledaid

@ Plate and flat tube attachment

[tis used for printing characters on flat tubes.

*This printer does not support printing on plates.

*One each of the cleaner (blue) and plate cleaner (gray) are included.

=)
o
c
—t
S~
m
o}
=

SABS/1ULId

@ Tube attachment * This component comes packaged with this product.
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List of Function

The functions that can be set for each function key are as follows. All functions can be set using

the [Option] key.

|PC Connect

[ [Option] key —t—{Connect

Warmer

Warmer Control

Warmer Temp.

—— Character Edit

Numbering

[Number] key |

Symbol

—
1

[Symbol] key |

—Page Edit

Insert

Delete

Copy

Cut

Paste

Division

Combining

—1Page Settings
*1

Character Size

F——  [Stylelkey |

Lines

Character Space

Orientation F—— [Formatlkey |
Frame

Cut Length —| [Length/Margin] key |
Alignment

Batch (Cut Length)

Continuous Print

F——1 [Contilkey |

*1The order in "Page Settings" may differ from what is actually displayed on the screen.
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Print Settings

Half cut

Full cut

Underline 6,9

Delete All

Text only

—

[Delete] key

Text+settings

File

Save

——

[Regist] key

Load

Delete

Print adjust

Top position

Vertical Position

Length

Half Cut Depth

Half Cut Motion

Full Cut Depth

Full Cut Motion

Print contrast

Setting

Print speed

Display contrast

Backlight (ADPTR)

Backlight (BAT)

Sound

Others

Remove

-

[Remove] key

Cleaning

Forced full cut

Feed

Replace cutter

Auto Off (adapter)

Auto Off (battery)

Auto Backlight Off

Init. Delete Check

Page Display

Counter

Device Info.

Firmware update
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List of Symbols

<Symbol 2>

@ =AMEHO
O0eTeaRK
o BIDNIO] =] =]
PEOEFTAOR-
4= RD [
LIGQ@REBEHT
OB X NEE®E
CFIA@WMWEBQG
[SI[E]

196



Index

A

AC adapter 12
AC adapter connector 3
Alignment 10, 56
Arrow keys 7,38
Auto backlight off 164
Auto off (Adapter) 160
Auto off (Battery) 160
B

Backlight (ADPTR) 163
Backlight (BAT) 163
[Back Space] key 41
Batch setting 59
Battery 13
Battery case 3
Battery cover 3
Blade receiver 4
C

[Caps Lock] key 7,8,39
Changing the folder Nname ... 105
Character input display 15
Character size 10, 43
Character space 10, 48
Cleaner 5,21,192
Cleaning/Replacing the cleaners ... 155
Cleaning the print head 154

Cleaning the transport roller

Connector for ribbon cassette ... 4
Connector for tube Warmer ......eeeveese 4
Continuous print 79

Cont print 10,79
Copy page 61
Cover 3
Cursor 10,38
Cut length 10, 55, 56
Cut page 63
Cutter 4
Cutter set 192
D

Delete all 42
Delete file 103
Delete page 66
Device information 185
Display 4,8
Display contrast 162
E

Entering symbols 40
[Enter] key 60
F

Feed 171
Feed error 168
Forced full cut 95
Format setting 42,133
Frame 10,45
Full cut depth 93
Full cut motion 98
Full cut setting 90
H

Half cut depth 91




Half cut motion 9

Half cut settings 8,88
|

Init. DeleteCheck 16
Initializes the printer 166
Insert page 65
Installing the software 108
Internal memory 189
J

Jam recovery leVer ... 4,27,153,169
K

Keyboard 3,6
L

Label tape cassette 25,192
Length adjust 84
Lines 10,49
List of function 194
List of message (Printer display) ... 180
List of message (Status MONitor) ... 147
List of symbols 196
Load file 101
M

Maximum printable character Size ... 44
Media delivery port 4
Media feed port 4,23
Memory used 37
MK Desktop Utility 108
Mounted cutter count 159

N

Numbering 51,136
o

Orientation 10, 46
P

Page 10
Page break 37,60
Page combining 69
Page division 67
Paste page 64
PC connection mode 118
Plate and flat tube attachment ... 21,193
Plate cleaner 193
Power cord 12
Power key 3,15,17
Power Supply 9,12
Print 72,138
Print density 86
Printer status 146
Print head 4

Printing preference display ......

[Print] key 7
Print preview 76
Print range 77
Print speed 8,87
R

Rating plate 3
Remaining ribbon 9,146
Replacing the cutter 156
Ribbon cassette 192




Ribbon cassette information display ... 15

S

Save file 99
[Settings] key 194
Size switch lever 5,22,32
Sound 165
Space key 7
Startup display 15
Status monitor 144
T

Top adjust 81
Transport roller 4
Tube attachment 5,21,193
Tube retainer lever 523
Tube warmer 31,193
u

Underline 6,9 54
Uninstalling the software ... 115
Updating the firmware 185
USB connector 3
Vv

Vertical adjust 82
W

Warmer control 9,33
Warmer Control 34
Warmer temp. 35
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